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CHAPTER 1

The Xpress-IVE Editor

The intelligent editor built into Xpress-IVE offers all the features of a modern programmer’s text
editor, plus enhancements designed to simplify working with Mosel models or LP and MPS files.

m The editor supports Mosel language syntax highlighting

m Two types of highlighting denote:

1. Mosel language keywords;
2. Identifier names defined in Mosel extension modules (dso’s)

B Mouse over information on most identifiers in a model:

! One position per Jjob

Seguence of jobs
forall(k in 1..NJ-1)

Start times

Completion times

forall(j,k in JOE3) rankﬁ,

forallik in JOBS) CompletionTimes (k) :=comp (k)

k) is_hinary

foralli(j in JOB3I) OnePositionPerJob(j):=sumik in JOB3) rank(j.,k)] = 1

Sequence (k) :=start (k+1) >= startik) + sum(j in JOB3) DUR(]j) *rankij,k)

forall(k in JOEBES) 3StartTimes (k) :=starti(k) >= sum(j in JOBE3) EREL(]j) *ranki(j, k)

= start (k)] + sum(j in JOBEZ) DUR(j) *ran

! Objective Ffunction 1: min
forallik in JOB3) Completi
minimize (£inish)
print_sol{l)

! Objective function Z: min
minimize (swn(k in JOB3) coy
print_sol{z)

! Objective Ffunction 5: min
forallik in JOB3) Tardines
minimize (swn(k in JOE3) la

rank.
arrav(JI0ES, J0BS) of mpvar | =1 if job j at position k

rank has 2 dimension(s) and a total of 439 decision variables):

rank[1,1] = Solution: 0, Reduced cost:
rank[1,2] = Solution: 0, Reduced cost:
rank[1,3] = Solution: 0, Reduced cost:
rank[1,4] = Solution: 0, Reduced cost:
rank[1,5] = Solution: 1, Reduced cost:
rank[1,6] = Solution: 0, Reduced cost:
rank[1,7] = Solution: 0, Reduced cost:
rank[2,1] = Solution: 0, Reduced cost:
rank[2,2] = Solution: 0, Reduced cost:
rank[2,3] = Solution: 0, Reduced cost:

oooooooooo

ES) DUE(3) *rank(j, k)

print_sol(3)

l |

5l

Xpress IVE

(©Copyright 1983-2014 Fair Isaac Corporation. All rights reserved.

page 1



m Auto-complete feature: Press CTRL+Space to obtain a list of Mosel keywords and other

identifier names that can be inserted at the current location:

One position per Jjob ;I
forall(j in JOBS) OnePositionPerJoh (i) :=suwik in JOBS) rank(j, k) =1

Seguence of Jjobs
forallik in 1..HJ-1)
Sequence (k) :=start (k+1) >= startik) + sum(j in JOE3) DUR(]j) *rankij.,k)

Start times
forall(k in JOESZ) 3tartTimes(k):=start(k) >= sum(]j in JOBE3) REL(]) *rank(j,k)

Completion times
forall(k in JOBS) CompletionTimesik):=compik] = start(k)] + swo(j in JOBZ) DUR{j) *ran

forall{i,k in JOBS) rank(j,k) is binary

st
o sqlrowsr [mimodbe. ctl] ;I
for
- |sglsuccess [mmodbe. ctl]
mlr_l SOLupdate [mmodbe. proc)
pr zqlverboze [mmadbe. ctl]
, =qrt
: O anay[JOBS] of mprvar | Start time of job at position k 1
miry -
C|StartTimes
PE M tarecut [mimsprs. func]
, storecuts [mirmxprs. proc]
: fO strfmt [Mozel func] T
C_‘r strifng [t ozel bype] 3.k
I st [t ozl func] ;I
pri - =

m When pressing CTRL+Space as a function, procedure or array name is typed in, the signature
(list of parameters or index sets) will appear in a tooltip, highlighting each parameter as it
gets typed:

4]

! One position per Job ;I
forall(j in JOEBES) OnePositionPerJob(]j):=sumik in JOBS) rank(j, k) = 1

Segquence of jobs
forall(k in 1..HJ-1)
Sequence (k) :=start (k+1) >= startik) + sum(j in JOBE3) DUR(]) *rankii,k)

Start times
forall(k in JOBS) StartTimes (k) :=starti(k) >= sum(j in JOB3) EEL{j) *ranki{j, k)

Completion times
forall(k in JOEBES) CompletionTimes (k) :=comp(k) = start(k) + swo(j in JOE3) DUR(Jj) *ran

forall{j,k in JOB3) rank(j,k) is binary

start|

! Objéarray[JDBS]ofmpvar | Start time of job at position kl: completion time
forall(k in JOEBE3) CompletionTimes (k) :=finish >= comp (k)
minimize (finish)

print_sol(l)

! Objective function 2! minimize average completion time
minimize (swo(k in JOBE3) cowp (k)]
print_soliz)

! Objective Ffunction 3! pdnimize total tardiness

forall(k in JOE3) Tardiness(k):=late(k) »= cowmpi(k] - sumi]j in JOEZ) DUE(]) *rankij,k)
minimize (swo(k in JOE3I) late (k)]

print_sol(3)
-
| »

m Editor settings are available by right-clicking in the editor window and selecting Properties...
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CHAPTER 2

Xpress-IVE Menus

2.1 The File menu

[ New..

Open...

Close

@ Save

Save As...

Print...
Print Setup...

1 catenary.mos

2 coco.mos

Exit

Mew Resource...

Save As HTML...

Send by Email...

3 Chxpressmph...
4 Chxpressmpl...
5 Chxpressmp'..,
6 Chxpressmph...
1 Chxpressmph...
8 Chxpressmp'..,
9 Cxpressmph...

Ctrl+N

Ctrl+0

Ctrl+5S

\prime.mos
\burglarl.mos
‘\chess.mos
\d2ship.mos
\xad\005gui.mos
\Polygonl.mos

‘\contract.mos

10 Chxpressmph..\binpacking.maos

I:I New...

New Resource...

Open...

Close

B Save

Save As...

Save As HTML...

Print...

Create a new file.

Create a new resource file.

Open an existing file in the editor.

Close the file currently shown in the editor.

Save the file currently shown in the editor.
Save the file currently shown in the editor under a different name.

Save the current file in HTML format, preserving formatting and
colors. Example The HTML code can be copied to Microsoft Word or
other rich text format editor, for inclusion in documentation,
papers, etc.

Print the current file.

Xpress IVE
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Print Setup...
Send by Email...
Recently used files

Exit

2.2 The Project menu

MNew...
Open...
Close

Save

Save As...

New...
Open...
Close

Save

Save As...

2.3 The Edit menu

S Unde

&8 FEind...
Replace...

Go To Line...

ie Erase Bookmarks

Select all

Change printer settings.
Send the current file by email if a registered MAPI handler exists.
Open one of the ten most recently used files.

Quit Xpress-IVE.

Create a new Project.
Open an existing Project.
Close the currently open Project.

Save the currently open Project and any modified files contained
within it.

Save the currently open Project, under a different name, and any
modified files contained within it. (Note that if you save the project
file to a different directory, you will receive a warning that any files
with relative paths will not be updated relative to the project’s new
location.) For more information on use of Projects in Xpress-IVE, see
the Help entry on the Project Explorer Bar.

Revert the editor to the state before the last editing action.
Cancel the previous Undo operation.
Cut the selected text and place it in the clipboard.

Place a copy of the selected text in the clipboard.

Xpress-IVE Menus

(©Copyright 1983-2014 Fair Isaac Corporation. All rights reserved. page 4



=~ Paste Insert the contents of the clipboard at the current location.
] Find... Open the search dialog.

Replace... Open the replace dialog.

Go To Line... Go to any line number in the editor.

=2 Erase bookmarks Remove any bookmarks placed by a recent search.

Select All Select the entire text buffer in the editor.

2.4 The View menu

z Mavigation Toolbar

z Tools Toolbar

Z Execution Toolbar

z Project Bar

z Info Bar

Z Run Bar

z Line Mumbers

z Left Margin

E] Repair Window Layout

Scheduling dashboard

Navigation Toolbar Show/hide the toolbar showing navigation buttons.
Execution Toolbar Show/hide the toolbar showing execution buttons.
Tools Toolbar Show/hide the toolbar showing debug tools buttons.
Model Explorer Bar Show/hide the Model Explorer Bar.

Project Explorer Bar Show/hide the Project Explorer Bar.

Info Bar Showr/hide the Info Bar.

Run Bar Show/hide the Run Bar.

Line Numbers Show/hide line numbering in the editor.

Left Margin Show/hide a margin on the left side of the editor. Bookmarks will

appear here.

i | Repair Window Layout In case the bars in IVE are positioned wrongly or lost, select to reset
the layout to the shipping default
Stochastic dashboard Showr/hide the Stochastic modeling dashboard when available.

Scheduling dashboard Show/hide the Scheduling dashboard when available.

Xpress-IVE Menus (©Copyright 1983-2014 Fair Isaac Corporation. All rights reserved. page 5



2.5 The Build menu

& Compile F7
& Run F&
w3 Options...,
‘| Export matrix...

3 .
“r+ Compile

L-] Run

Hl] Pause

Stop

—3{' Options...

= Export matrix...

2.6 The Debug menu

=® [efget Breakpaint Fa

ol

W Start ] Continue FS

3 Step aver F10
Step inko F11

L

ﬁ Debug Options...

\3 Prafile

Re/Set Breakpoint

ng

#" Set breakpoint condition

Saves and compiles the current .mos (Mosel) file. If there are
compilation errors, they will appear in the Info Bar. If compilation is
successful, the entity tree will be populated with entities from the
model.

Saves, compiles and executes the current .mos (Mosel) model.
During the execution, the output from Mosel will go to the Output
pane from the Run Bar. After the run terminates the entity tree will
show actual values taken by variables in the Mosel model.

Uncheck this option to resume the execution after it has been
paused.

Attempt to interrupt the execution of a model or an optimization
by requesting that Mosel and the Optimizer stop. Mosel/the
Optimizer will stop whenever it is safe to do so.

Shows the Run options dialog, allowing the user to change settings
for Mosel or Optimizer runs. It can also be invoked while a Mosel
model is executing or during the optimization of a matrix file.
Changes will take effect immediately after the dialog is dismissed.

Shows the Export matrix dialog for exporting matrices produced
during Mosel runs to LP or MPS files.

Sets or removes a breakpoint on the current line.

Invokes the Breakpoint condition dialog.

Xpress-IVE Menus
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ﬁ Start/Continue

iiﬂ Step over

£

=4
< Step into

¥ Run to cursor

ﬁ Debug Options...

\9 Profile

2.7 The Deploy menu

Deploy...
i Self Executing Madel

Deploy...

LY Self-Executing Model

2.8 The Modules menu

3 Create a new module...

List available modules

il Create a new module

List available modules

Saves, compiles and begins/resumes debugging the current .mos
(Mosel) model. While debugging, the execution will stop at
breakpoints or can be controlled manually by stepping into the
code. When the execution is interrupted, values for all identifiers
(including those with a local scope) are available. Also, the Debug
watches in the Info bar are updated.

While debugging, advance the execution point by one line,
stepping over functions/procedure calls.

While debugging, advance the execution point by one line,
stepping into functions/procedures.

While debugging, run to the line where the editing cursor is
positioned.

Shows the Debug Options dialog for modifying the behavior of the
debugger.

Saves, compiles and begins running the current .mos (Mosel) model.
Every monitoring feature in IVE will be turned off to eliminate
overheads; statistics will be gathered regarding time spent on every
line of Mosel code. At the end of the run, the profiler output will
be produced.

Opens the Deploy dialog.

Opens the Self-Executing Model dialog.

Opens the New Module Wizard dialog.

Opens the List Modules dialog.

Xpress-IVE Menus
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2.9 The Wizards menu

2.10

1. Name & Type Ctrl+1
2. Parameters Ctrl+2
3. Data Input Ctrl+3
4. Variables Ctrl+4
5. Objective Ctrl+5
6. Constraints Ctrl+6
1. Results & tuning Ctrl+7
8, Text Output Ctrl+8
9. Graphing Ctrl+9
10. Programming etc.  Ctrl+5hift+0
11. Debugging Ctrl+5Shift+1
12, Complete models  Ctrl+5hift+2

# 13 More wizards...
Deploy...

@ Self Executing Model...

d New Module...

-

. Name & Type Wizard

. Parameters Wizard

. Data Input Wizard

. Variables Wizard

. Objective Wizard

. Constraints Wizard

. Results & tuning Wizard
. Text Output Wizard

O 0 N oo v A~ W N

. Graphing Wizard
10. Programming Wizard
11. Debugging Wizard

12. Complete models Wizard

# 13. More wizards...
Deploy...
LY Self-Executing Model

izl Create a new module

The Window menu

Cascade
Tile

Arrange Icons

Invokes the Name & Type Wizard
Invokes the Parameters Wizard
Invokes the Data Input Wizard
Invokes the Variables Wizard
Invokes the Objective Wizard
Invokes the Constraints Wizard
Invokes the Results & tuning Wizard
Invokes the Text Output Wizard
Invokes the Graphing Wizard
Invokes the Programming Wizard
Invokes the Debugging Wizard

Invokes the Complete models Wizard
Invokes the Wizard viewer without selecting any particular wizard
Opens the Deploy dialog.
Opens the Self-Executing Model dialog.

Opens the New Module Wizard dialog.

Xpress-IVE Menus
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Cascade Cascade the opened windows.
Tile Tile the opened windows.

Arange Icons Arrange icons when all windows are minimized.

2.11 The Optimizer menu

- Repair infeasible problem. ..

=l Optimize matrix file... ‘

| Find M best solutions. ..

—FJ Optimize matrix file...  Shows the Optimizer dialog which allows for the optimization of
matrices in LP or MPS format.

i Repair infeasible problem... Shows the Optimizer dialog with options for relaxing an
infeasible problem.

_l Find N best solutions... Shows the Optimizer dialog which options for finding alternate
optimal solutions.

2.12 The Help menu

¥press Help...

About ¥press-IvVE...

& Rpress-IVE Help... ‘

Xpress-IVE Help... Opens this help system.

Xpress Help... Opens the comprehensive Xpress Help system which includes
in-depth documentation on all Xpress products.

About Xpress-IVE... Shows the About dialog, including version and copyright
information.

Xpress-IVE Menus (©Copyright 1983-2014 Fair Isaac Corporation. All rights reserved. page 9



CHAPTER 3

Xpress-IVE Toolbars

The Bars display rich information on the status of Xpress-IVE, the degree of success in
compiling/running Mosel models, and results from runs. In addition, the Bars simplify user
interaction with the application by placing most controls within easy reach. The Bars can be
resized or repositioned—settings are always saved on exit.

3.1 The Toolbars

3.1.1 Navigation Toolbar

&= % = -l |8 g8 [ @ search: File Positian:
I_I Create a new file and open it in the editor. (also present in File menu)
Open an existing file in the editor. (also present in File menu)
B Save the file currently shown in the editor. (also present in File menu)
“4° Cut the selected text and place it in the clipboard. (also present in Edit menu)
Il_l Place a copy of the selected text in the clipboard. (also present in Edit menu)
I-wl__lﬁ Insert the contents of the clipboard at the current location. (also present in Edit menu)
k_l] Go to the previous position in the editor (also present in View menu)
|_EE\[ Go to the next position in the editor (also present in View menu)
Tf Go to the previous indentation level (also present in View menu)
J-II-- Go to the next indentation level (also present in View menu)
é’ Undo last text editor action (also present in View menu)
é Redo last text editor action (also present in View menu)
=2 Remove any bookmarks placed by a recent search. (also present in Edit menu)
i) Search within the text editor. (also present in Edit menu)
i | Repair Window Layout (also present in View menu)

! Show the Xpress-IVE help system.
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3.1.2 Execution Toolbar
# B3 E = NE N 3
# Show the Wizards Dialog:

m Show the 1. Name & Type wizard. (also present in Wizards menu)
m Show the 2. Parameters wizard. (also present in Wizards menu)

m Show the 3. Data Input wizard. (also present in Wizards menu)

m Show the 4. Variables wizard. (also present in Wizards menu)

m Show the 5. Objective wizard. (also present in Wizards menu)

m Show the 6. Constraints wizard. (also present in Wizards menu)

m Show the 7. Results & tuning wizard. (also present in Wizards menu)
m Show the 8. Text Output wizard. (also present in Wizards menu)

m Show the 9. Graphing wizard. (also present in Wizards menu)

m Show the 10. Programming wizard. (also present in Wizards menu)
m Show the 11. Debugging wizard. (also present in Wizards menu)

m Show the 12. Complete models wizard. (also present in Wizards menu)

Show the Deploy dialog. (also present in Dep/oy menu)

E¥ Show the Self-Executing Model dialog. (also present in Deploy menu)

u-:“ Save and compile the current model. (also present in Build menu)
-13{' Show the Run options dialog. (also present in Build menu)
L-] Save, compile and run current model. (also present in Build menu)

Hl] Uncheck to resume the execution after it has been paused. (also present in Build menu)
Interrupt the execution. (also present in Build menu)

-I.'j Show the Export matrix dialog. (also present in Build menu)

—DJ Show the Optimizer dialog. (also present in Optimizer menu)

% Show the Optimizer dialog with options to repair infeasible problems. (also present in
Optimizer menu)

_l Show the Optimizer dialog with options to find alternate optimum solutions. (also present in
Optimizer menu)

Show the List Modules dialog. (also present in Modules menu)

iZ1 Show the New Module Wizard dialog. (also present in Modules menu)
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3.1.3 Tools Toolbar

2 e & v

=% 0

r

ng

=]

= Re/Set breakpoint. (also present in Debug menu)

Set/Remove breakpoint condition by invoking the Breakpoint condition dialog. (also present

Debug menu)

Start/Continue debugging. (also present in Debug menu)

L Step over. (also present in Debug menu)

LII_

=4
= Step into. (also present in Debug menu)

= Run to cursor. (also present in Debug menu)

ﬁ Invokes the Debug Options dialog. (also present in Debug menu)

@ Start profiling the Mosel model. (also present in Debug menu)

3.2 The Model Explorer Bar showing the entity tree

Can be shown/hidden by selecting Model Explorer Bar from the View menu or by clicking the

icon on the Project pane.

The Model Explorer Bar contains the entity tree, the A->Z entity list and the most recently

accessed entities combo list:

Model Explorer n Model Explorer n
[ Problems '] [ Problems ']
K]l < Solution [n/a] > k< Solution [n/a) >

Entities |A--> Z Entities |A--> Z
Parameters Parameters
Constants Constants

= Frimitives Primitives

CoE{} ets 2} sets

i -4i} MODELS ~{i} MODELS
-{i} SUBPROBS -{i} SUBPROBS
~{i} vARS (i} vARS
Subroutines Subroutines
User-defined Types User-defined Types

23 Problems 23 Problems
Main Problem tain Problem

=~ SubProblems(1)

538 Decision Variables
=11 araps:

- {¥] values
Constraints

- » scalars

L% constrain_sum
SubFroblems{2]
SubPrablems{3]

B~ SubProblems{1]

- ¢} Decision Varishles
211 amaps:

- [v] values
Constraints

- » scalas

L% constrain_sum
SubProblems(2)
SubProblems(3]

Model Explorer

conshrain_sum
values
I

1

[C:\jobshpapers.mos]
s¢ Parameters

Constants

Frimitives

:3 “ sets:

-{i} MODELS
{i} SUBPROBS
i} VARS
Subroutines
User-defined Types

538 Problems

M ain Problem

B~ SubProblems(1]

- s} Derision Varisbles
=[] arays:

L[] values
Constraints

* scalars:

L% constrain_sum
SubProblems(2)
SubPrablems(3]

T35

L)

After the successful compilation of a Mosel model, the entity tree will be populated with

Model Explorer | s23 Project Explorer

2w Model Explorer | s53 Project Explorer

saw Model Explorer | 23 Project Explorer

n

identifiers from the model. After a successful execution of the model, the values of the identifiers

Xpress-IVE Toolbars
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appear in tooltips when the mouse is nearby. The complete values can be examined by double
clicking on an identifier (which will open the View text dialog). If a model is being solved for
multiple solutions, then the controls under recently-accessed entities list can be used to select a
given solution (the best solution is chosen by default).

The identifiers are grouped in the following categories:

Parameters
Parameters can have the same type as Mosel primitives, but they are special entities as they can
be used to pass information to a model without having to edit it.

Constants
Constants also have regular primitive types, but their values cannot change at runtime.

Primitives

These are primitive types (integer, real, boolean, string) either standalone or grouped into sets or
arrays.

User types (defined within Mosel modules) will also appear here. Refer to the Mosel Native
Interface documentation for details on how to define and use such external types.

Note that if user types do not support conversion to/from text, the values shown here will be
meaningless.

Subroutines
A list of all the functions and procedures defined in the current model.

Problems

The main Mosel problem, and any other variables containing problem objects (which can be
selected in model by use of the Mosel with statement). In the example images above, the model
contains an variable called SubProblems, an array of 3 mpproblem objects.

Those entities which are displayed specific to a given problem are:

Decision variables

Representing the special mpvar Mosel type, decision variables are characterized by solution value
and reduced cost after a successful optimization.

Linear constraints

Representing the special linctr Mosel type, linear constraints are characterized by activity value,
slack and dual value after a successful optimization.

Note that decision variables and linear constraints will only display correct values if the
optimization was successful and a solution was found.

3.3 The Project Explorer Bar

Can be shown/hidden by selecting Project Explorer Bar from the View menu or by clicking the 1
icon on the Project pane. Creation, loading, and saving of Project files is handled by the Project
menu.
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Praject Explorer i

=8

fs Ci'wpressmplexamplesljve\els.mos
Jfe parent.mos

[ Sub-Models

i Jfie child,mos

saa Model Explorer | s5a Project Explorer

Projects in IVE are a collection of files (which can be any type, not just Mosel or XAD resource
files), along with the options specified in the Run Options dialog. One can classify the files in a
Project into a hierarchy of folders (not be confused with file system directories). Thus you might
wish to arrange files in a Project according to purpose, for example:

m sub-models in one folder, and the main models that use them in another (or at the top
level);

m a folder for each file type (as is the default behaviour for projects in Microsoft Visual Studio);

m folder layout to mirror the hierarchy of files on disk.

Files in a project will be stored as either absolute or relative paths. If a file in a project is in same
directory as the project itself, or one of its subdirectories, its path will be stored relative to the
project file's directory. A file from outside this directory hierarchy will be stored as an absolute
path. In the example image above, the files parent.mos and child.mos are stored in the same
directory as the project, whereas the file els.mos is in an unrelated directory and so is stored as an
absolute path. Files with absolute paths have the =% stylised colon-backslash symbol overlaid on
their icons in the project tree.

3.3.1 Operations on Projects

There are a number of actions one can perform with a Project. Many of these are started by
bringing up a context-menu, typically by right-clicking the mouse on an item in the project tree.
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3.3.2 Pop-up menu for the Project

Add Files...
Add Folder

Save

Save As..

Add Files...
AddFolder
Save

Save As...

3.3.3 Pop-up menu for files

i
Rename...

Remove from Project

Rename

Remove from Project

3.3.4 Pop-up menu for folders

Add Files...
Add Folder

Rename Folder...

Remove Folder from Project

Add Files...

AddFolder

Rename Folder

Remove Folder from Project

This brings up a file dialog box allowing the user to add files to the
top level of the Project

This creates a new empty Folder (as a direct child of the Project),
which can then be renamed and populated.

Same as the Save action on the Project menu. (When you save a
Project, all modified files within it are also saved).

Same as the Save As action on the Project menu. (When you save a
Project, all modified files within it are also saved).

This makes the file name editable. See Editing file and folder names
below. This can also be acheived by selecting the item in the Project
tree and pressing F2.

This removes the file from the project, but does not delete it from
disk. This can also be acheived by selecting the item in the Project
tree and pressing the Delete key.

This brings up a file dialog box allowing the user to add files to this
folder.

This creates a new empty folder (as a direct child of this folder),
which can then be renamed and populated.

This makes the folder name editable. See Editing file and folder
names below. This can also be acheived by selecting the item in the
Project tree and pressing F2.

This removes the folder (and any contents) from the project, but
does not delete any files from disk. This can also be acheived by
selecting the item in the Project tree and pressing the Delete key.

Xpress-IVE Toolbars
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3.3.5 Drag-and-Drop within the Project tree

In order to rearrange the structure of the Project hierarchy, files and folders can be moved by
Drag-and-Drop with the mouse. For instance, when a new folder has been created, other files or
folders can be dragged into it.

3.3.6 Editing file and folder names

When a file or folder is made editable, a text box is brought up over its location with the current
contents selected. Having adjusted the name, press the Enter key to confirm the change, or the
Escape key to cancel. If you are renaming a file that is open in the IVE editor, the file will also be
renamed in the editor. Note: you cannot use this method to move files to different directories,
merely to rename files with a directory; this is why only the file name is editable, not the whole
path.

3.3.7 Run options

When a Project is saved, the contents of the Run options dialog are saved with it. These options
are then restored when the Project is reloaded. This facilitates keeping files together with their
relevant settings.

3.3.8 The PROJECTDIR parameter

If a Project is laoded when a model is run, then a Mosel parameter named PROJECTDIR is set to
the full path of directory in which the poject file is located. This value can be accessed in the
usual way via a Mosel parameters...end-parameters block. This value can be seen in the Run
options dialog. (If the users sets a Mosel parameter PROJECTDIR via the Run options dialog, this
will override the Project-supplied version).

3.4 Info Bar

Can be shown/hidden by selecting Info Bar from the View menu or by clicking the icon on the
Information pane.

The Info Bar consists of three views:

1. Build — Shows the status of the compilation of a Mosel model and reports errors if any. Click
on an error to make the editor navigate to the offending line in the model. When running a
model, some brief statistics and version information appear here. Press the button Copy to
clipboard to copy the contents of the Build view to the Windows clipboard. Then paste into any
text editor/email client.

Information q

C:Awpressmphexamplesimosel\odelingtcoco.mas compiled successfully Last matrix

Mosel version: 25.3

Module(s) in use: mmaprs version 1.9.2, mmive version 1.20.0.
q C:epressmptexamplesimoselyModeling'.coco

Build | "Main Problem” locations | Debug Watch Copy to cliphoard -

Ready Idle Free Memory: 672 ME  Line: 38/176 Cal: 0
2. "..." locations — When an entity is clicked on in the entity tree, all the lines where the entity is

present are added to this clickable list. Click on a line in the list to highlight it in the editor.
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Information

CBUY: C:\spressmphesamplessmosel\Modelingycoco.mos [Line: 38)  CBUY: amay(RAR.AT) of real P Unit cost to buy raw material 1 Last matrix
CBUY: C:\upressmphexamplesimosel\Modelingtcoco mos [Line: 73] - CBUY - [100, 98, 97,100,
CBUY: C:Aspressmphesamplessmosel\Modelingycoco.mos [Line: 300 sum(r in RR.fin RF.tin RT) CELUYILE = buylif - | raw mat. cost

I Build | "CBUY" locations | Debug \Watch

Ready Free Memory: 653 MB Line: 38/176 Cal: 5

3. Debug watch — Editable list of identifiers whose value is shown.

Information

|dentifier Value -~ Last matriv

buy(1.1.1] Solution: 420, Reduced cost: 0
RP 1.2}

RT {1234

Build | "CBUY" locations | Debug Watch

Ready Ide Free Memory: 642 ME  Line: 50/176 Col: 35

In addition, the Info Bar shows a sketch of the latest matrix loaded in the Optimizer. Note that
the matrix may be "presolved".

3.5 Tools Bar

Can be shown/hidden by selecting Tools Bar from the View menu or by clicking the

|_=' button on the Toolbar.
blending.mos |[ a4 mps 8 £ & # | =1

The Tools Bar is made up of five regions:

m On the left, a list of buttons corresponds to the files opened in the editor. Switch from one
file to another simply by clicking the button having the chosen file name.

m The @(Ctrl+Alt+Left) and I_ET.!\[(CtrI+AIt+Right) buttons navigate through current and
previous locations in the editor.

m The f (Ctrl+Alt+Up) and g-L--(CtrI+AIt+Down) buttons find a previous or next line in the
editor with the same indentation level as the current line.

m The Find button (marked by binoculars) opens the search dialog.

— The search box can be typed in or pasted to from the clipboard. Press Enter to
repeatedly search in the current file for occurrences of the word or expression in the
search box.

— The small progress bar below the search box shows the position of the editing cursor in
the current file.

m The context Help button - if pressed, it will attempt to find Help on the current word in the
editor.

3.6 Run Bar

n

Can be shown/hidden by selecting Run Bar from the View menu or by clicking the icon on the

Run pane.
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The Run Bar groups together the following tabs/panes: Output/Input, Stats, Matrix, Solutions,

Objective, MIP search, BB tree, SLP progress, User graph, CP stats, and CP search.

The Run Bar can be put into space-saving mode by enabling the Auto hide checkbox: when the
mouse leaves the area of the Run Bar and enters the editor, the Run Bar will be hidden almost

completely. When the mouse re-enters the Run Bar, it expands to its previous dimensions.

Below are snapshots of the different tabs/panes:

3.6.1 Output/Input

Mosel output

Console-style user input:

Output/Input e Output/Input a2
s What is your name? -~
Here are the LF results . Steve B
Objective value is 1333.33 Hello, 3Steve
Make 0 small sets, and 66.6667 large sets
Here are the IP results
Objective value is 1330
Make 2 small sets, and 66 large sets
| » i
4 [am
OQutput/Input | Stats | Matrix | Solutions | Objective |
MIP search | BB treel User graph | Is OQutput/Input | User graph | s |
Profiler output:
Qutput/Input .
-
44 Profiling results 44
Line / File name /  Total time [/ Executed
LINE: 77 (mincostf 5 msec 24 times.
LINE: 72 (mincos 1 times.
LINE: 94 (minc 15 times.
LINE: 95 15 times.
LINE: 89 (minc 1 times. £
LINE: 99 (minc 16 times.
LINE: 91 (mincos 1 times.
LINE: 98 (mincos 24 times.
LINE: 100 ({minc 16 times.
LINE: 59 (minc 13 times.
LINE: 64 (minc 2 times.
LINE: 65 (minc 2 times.
LINE: 103 ({minc 2 times.
LINE: 34 (minc 1 times.
LINE: 36 (mincostfl 1 times.
LINE: 37 (mincostfl 1 times.
LINE: 38 (mincos 03) : 1 times.
LINE: 41 (minc 03) 1 times.
LINE: 45 (mincostf 03) : 1 times. 52
4 | I | 3
Output/Input | Stats | Matrix | Solutions | Objective | MIP search | BB trEEI User graph
1s
Debugger output:
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LINE: 20 (harp2.mos) :
LINE: 20 (harp2.mos) :

LINE: 27 (harp2.mos) @ R[=array<ll3>] ("BIRO") :=
LINE: 28 (harp2.mos) @ R[=array<ll3>] ("BIR9")
LINE: 29 (harp2.mos) : R[=array<l13>] ("BRCO"™)
LINE: 30 (harp2.mos) : R[=array<l13>] ("BROS"™)
LINE: 31 (harp2.mos): R[=array<l13>] ("BR20"™)
LINE: 3z (h_ar:p'Z.mus) : R[=array<113>] ("BR23"™)
LINE: 33 (harp2.mos) : R[=array<l13>] ("COCL")
LINE: 34 (harp2.mos) : R[=array<l13>] ("COLM")
LINE: 35 (harp2.mos) : R[=array<l13>] ("CONN")
LINE: 36 (harp2.mos) : R[=array<l1l3>] ("CONO™)
LINE: 37 (harp2.mos) : R[=array<l13>] ("CON3")
LINE: 38 (harp2.mos) : R[=array<ll3>] ("COUO™)
LINE: 39 (harp2.mos) : R[=array<ll3>] ("COUS"™)
LINE: 40 (harp2.mos) : R[=array<ll3>] ("CRVO")
LINE: 41 (harp2.mos) : R[=array<ll3>] ("CRVI")
LINE: 42 (harp2.mos) : R[=array<l13>] ("ELFA")
LINE: 43 (harp2.mos) @ R[=array<l13>] ("ESCO™)
LINE: 44 (harp2.mos) : R[=array<l13>] ("ESCI"™)
LINE: 45 (harp2.mos) : R[=array<l13>] ("FREM")
LINE: 46 (harp2.mos) : R[=array<l13>] ("FINK")

™

LINE: 20 (parp2.mos) @ forall (c[="1%L9A022"] in ["AGLSA012", "RGLSR022","AGLS =
in {"AGL3R01Z","AGLSR0Z2", "RGL3
in {"AGL3R01Z","AGLSR0Z2", "RGL3
LINE: 20 (harp2.mos) : forall(c[="1%L9A051"] in ["AGLSA012", "RGL5R022","AGL3
sum(c i
sum(c i
sumic i
sumic i
sumic i
sumic i
sumic i
sumic i
sumic i
sumic i
sumic i
sumic i
sumic i
sumic i
sumic i
sumic i
sumic i
sumic i
sumic i
sumic i

{"BIROAO11", "BIROA
{"BIRIAO1L", "BIRIE
{"BROOA011", "BROOA
{"BRO9A012", "BROIA
{"BR20A011", "BR20A
{"BR29A012", "BR29A
{"COCLAO12", "COCLA
{"COLMAO12", "COLMA
{"CONNAO12™, "CONNA
{"CONORO11", "CONOR
{"CON9AO012", "CONIE
{"COUORO11", "COUOR
{"COU9A011", "COUIE
{"CRVOR012", "CRVOA
{"CRV9R012", "CRVIE
{"ELFARO11", "ELFAR
{"ESCOR011", "ESCOR
{"ESCIR011", "ESCIR
{"FRAMAO12", "FRAMA
{"FINKRO012", "FINKA

Type here: |

OQutput/Input | Stats | Matrix |So|uﬁol\5 | Objective | MIP se,archl BBlleel User graph | s |

Optimizer output when a matrix file is run using the Optimizer Dialog:

Clear

Reading Problem ‘xprs_17a8_ 5aSda2d
Prcblem Statistics

112 0 spare) rows

2993 ( 0 spare) structural col

5240 ( 0 spare) non-zerc eleme
Gleokal Statistics

2993 entities 0 sets

Minimizing MILP ‘xprs_17a8_ S5ad9da20
Original preoblem has:

112 rows 2993 cols 5
Presolved problem has:
92 rows 1025 cols 2

LP relaxation tightened

Its 0Obj Value S Ninf MNne
0 -1088468011. D 72

100 -113378833.7 D 54

200 -81184011.79 D 20

300 -74358397.70 D 6

321 -{\g25169.35 D 0

Optimal solution found

Starting root cutting & heuristics

p—— .

Type here: | "

OQutput/Input | Stats | Matrix |So|uﬁons Objective
MIP search | BB tree | User graph | Is

3.6.2 Statistics

Optimizer status and statistics:
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Stats n

M atrix: Presolved:
R ows(constraintz]: 21 R ows{constraints): 20
Colurmns|wariables]: 23 Columng(variables): 23
Monzero elements: 430 MNomzen elements: 407
Global entities: 23 Global entities: 23
Sets: 1} Sets: 1]
Set members: 0 Set members: ]
Owerall status: Finished global search.
LP relazation: Global search:
Algorithm: Simplex dual Current node: 131
Simplex iterations: 9 Drepth: 5
Objective: 1B E337 Active nodes: 0
Status; LF Optirmal Best bound: ia}
Time: 0= Best salution: i3]
Gap: 0%
Status: Solution iz optimal.
Tirne: 0.6z
Time overheads:

Progress agraphs: 01s

‘wiiting autput: 0.0z

Pausing: 0.0z

Updating status: 01s

Output/Input | Stats | Matrix | Solutions | Objective | MIP search | BB tree |—
Is

3.6.3 Matrix

A zoomable view of the matrix:

Matrix i

Column view | Row view | Graphical criginal | Graphical presolved | Sca * | *

Columns
1] 10 20
: ! --...--:"

R EI R B

Qutput/Input | Stats | Matrix | Solutions I Objective | MIP search I BB tree |_
SLP | User graph | s |

3.6.4 Solutions

The last N solutions found by the Optimizer:
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Wiew lagt M zolutions found by the Optimizer

4 1 ]

Column M amne Obij=
zmall
1 large
—— 2 time_used
~— 3 wood_uzed
—~ 4 TevenUe
— 5 wood_remaining
—~ g obj

1330 Obj=1325 Obj=13:
2 5
13 5
138 145
200 200
1330 1325 13
] ]
1330 1325 13

1

3

Output/Input | Stats | Matrix | Solutions | Objective | MIP search | BB tree |—

User graph | s

3.6.5 Objective

Objective value progress during Simplex or Newton barrier:

Objective

1

[Click for graph higtory

-

]

Simplex Objective variation

Objective

_______ [V =+ Objective
10 |[™ =+ heration

uojjee)|

Duality gap

v =+~ Duality gap

C}utplrb"[npu‘tl Stats |Matrix Solutions | Objective | MIP search | BB tree
SLP |Usergraph| Is

3.6.6 MIP search

Progress of the global search for integer solutions:
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-

[ == Gap
p.HegersoLﬁon
[ & Depth

yidag

[V == Best solution
<] | W ~+ Best bound
[V B Integer solutions

______________________________________

8

Objective

_____________________________

]

0 01 02 03 04 05 06 07 08
Time

| ‘stats | Matrix | Solutions | Objective| MIP search BB tree |

Output/Input
L5 ]

3.6.7 BB tree
The evolution of the Branch and Bound MIP search:

When paused, highlight nodes branching on

3.6.8 SLP progress

SLP progress:
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SLP =

SLP: Unconverged varables
8

||7+ Unconverged varables I

Unconverged variables
P N S

=

ot}

Objective

Time

MIP search | BB tree| SLP |User graph | s

Outputﬂnputl Stats I Matriz | Solutionsl Objecti\.re|

3.6.9 User graph

Graph constructed by user during the Mosel run:

User graph 3

z)

[ W Network
v B Used routes

[ Click far graph history

Output/Input | Stats I Matrix | Solutions | ijectivel MIP search I BB tree| User graph
s
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3.6.10 CP stats and CP search

Models using the Xpress-Kalis solver generate display in two additional tabs:

‘when paused, highlight nodes branching on

Qutput/Input | CP stats| CP search | User graph

Problem size
Variables: 259
Constraints: 415

Search statistics
Modes:

Maximum depth:
Backiracks:

Time:

Total propagation time:

Last call propagation time:
Total propagation iterations:
Last call propagation iterations:

Solutions

Objective: 104

Time: 1.559s

475

397
159s
0.0%4s

1534184
0

Output/Input| CP stats | CP search | Usergraph | 05 |

Clear

Here are the LP results
Objective value is 1333.33
Make 0 small sets, and 66.6667 large seta

Here are the IF results
Objective value i3 1330
Make 2 small sets, and 66 large sets

| T |

[Tupe here: | "

Output/Input | Stats | Matrix | Solutions | Objective
MIP search | BB lrecl Userglaphl s

3.7 The Output/Input tab of the Run Bar

All write and writeln statements in Mosel produce character output that can be viewed in this
window. Output from the Xpress Optimizer can also be shown by setting the boolean "mmxprs"

parameter XPRS_VERBOSE.

Notes:

m To scroll the Output window using the keyboard, click once on the window to obtain the

Xpress-IVE Toolbars

©Copyright 1983-2014 Fair Isaac Corporation. All rights reserved.

page 24



keyboard focus.
m Text can be selected and copied directly from the Output window.

m To clear the contents of the Output window, click on the Clear button.

3.7.1 User input in the Output/Input tab of the Run Bar

Output/Input 1

What is your name? -

. Steve

Hello, Steve

m

< [om r

|
Output/Input |User graph | s |

When the user is required to input text during a Mosel run (when the read or readln statements
are executed), the text can typed in the edit box marked Type here. (This edit box is disabled
except when expecting user input).

Notes:

m To send the typed text to Mosel, press Enter.

m After text has been input, the left margin of the corresponding line from the Output
window will be highlighted in blue.

m Call the Mosel procedure ff1ush to display all remaining text before asking for input.
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3.7.2 The Optimizer Output tab of the Run Bar

Output/Input 5

Clear

Reading PFroblem ‘xprs_lT7ad_5a%daz0
Problem Statistics
112 | 0 spare) rows
2993 | 0 spare) structural col
5840 ( 0 spare) non-zeroc eleme
Global Statistics
2993 entities 0 sets
Minimizing MILF ‘xprs_l7a8_S5a9daz0
Original problem has:

m

112 rows 2993 cols 5
Presolved problem has:
92 rows 1025 cols 2

LP relaxation tightened

Its Obj Valuse 5 Ninf HNne
[u] -1088468011. D 72
100 -113378833.7 D 54
200 -81184011.79 D 20
300 -74358397.70 D [
321 ~Tyg2s169.35 D 0
Optimal sclution found
Starting root cutting & heuristics
P T T T T

o
Output/Input | Stats | Matrix | Selutions | Objective
MIP search | BB tree | User graph | s

During a standalone Optimizer run (using the Optimizer dialog) or in the solving stage during a

Mosel run (if the "mmxprs" parameter XPRS_VERBOSE was set to true), a textual Optimizer
progress report will be produced in the Output window.

A typical output sequence from the Optimizer contains:
1. A short version and copyright message from the Optimizer, marked with a blue margin
(does not appear during a Mosel run).

2. Information on any control parameter settings, written in magenta (does not appear during
a Mosel run).

The problem reading phase and statistics, marked with a dark green margin.
The LP relaxation phase (Simplex or Barrier), marked with a light blue margin.

The global search phase (if applicable), marked with an orange margin.

o v & W

The nonzero values in the solution vector, if a solution exists (does not appear during a
Mosel run). These values are printed on alternating background colors to improve
readability. There is no relationship between the background color and the value shown.

7. To learn how to control the amount and frequency of textual output from the Optimizer,
please refer to the Xpress-Optimizer reference manual or the 7. Results & tuning wizard.
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3.7.3 Debugger output in the Output/Input tab of the Run Bar

COutput/Input

< |]

Type here:

20 (harp2
20 (harp2
20 (harp2
20 (harp2
27 (harp2
28 (harp2
29 (harp2.m
30 (harp2
31 (harpl.m
32(11_61;:?
33 (harp2
34 (harp2.m
35 (harp2.m
36 (harp2.m
37 (harp2.m
38 (harp2.m
39 (harp2.m
40 (harp2.m
41 (harp?.m
42 (harp?.m
43 (harp2.m
44 (harp2.m
45 (harp2.m
46 (harp2.m

¢ forall{c[="19L9A022"]

all (c[="19L9A0D32"]
all (c[="19L9A042"]
all(c[="19L9A051"]

: R[=array<113>] ("BIRO™)
: R[=array<113>] ("BIRS")
: R[=array<l113>] ("BROO™)
: R[=array<l113>] ("BR2S")
: R[=array<l113>] ("BR20"™)
: R[=array<l113>] ("BR23")
: R[=array<l13>] (" ")
: R[=array<113>] ("COLM

: R[=array<ll13>] ("CO

: R[=array<l113>] ("CONO

: R[=array<l13>] ("CON3

: R[=array<l13>] ("COUO

: R[=array<l13>] ("COU3

: RE[=array<113>] ("
: R[=array<113>] ("CEV:
: R[=array<l113>] ("ELER")
: R[=array<l113>] ("ESCO™)
: R[=array<l13>] ("ESCa")
: R[=array<113>] ("FREM")
: R[=array<l113>] ("FINK")

in {"AGLSR012", "M
in {"AGLSRO1
in {"AGLSRO1

in ["AGL3R01Z", "AGLSR0OZ

:= sum(c i
gum{c i
gum{c i
gum({c i
gum({c i
gum({c i
gum({c i
sum({c i
sum({c i
sum({c i
sum({c i
sum({c i
sum({c i
gum{c i
gum{c i
gum{c i
gum{c i
gum{c i
gum{c i
gum{c i

"BIROAOLL

CLAO12™
IMAO12™,
NHAO1Z™,
NORO11",
N9RO12",
UORO1L",
UIR01L",
no12",

"CRVOR012",
{"ELPRROIL",
{"ESCOR011",
{"ESCIR011",
{"FRAMRO12",
{"FINKRO12",

OQutput/Input | Stats | Matrix | Solutions | Objective | MIP search | BBtreEl User graph | s

"BIRSARO11™, ™
"BROOROLL™, ™
"BROSAO1Z™, ™
"BRZOAO1L™,™
"BRZIA01Z™, ™

'

EE-EE

"ELPAR —
"ESCOR
"ESCOR
"FRAMA
"FINKR

—

While debugging Mosel code, the user has the option of printing the current executed line. The

line can also be expanded to show current values of primitive identifiers (integers, strings,

booleans, reals) and current sizes of arrays and sets (see the Debug Options dialog for more
information).

Clicking on a line number will activate the corresponding line in the editor.

3.8 The Stats tab of the Run Bar

Stats 1
M atrix: Presolved:
Fiowsz[constrainkz]: 21 Fows[constraints]: 20
Colurnz|wanables): 23 Colurmns|variables): 23
Monzero elements: 430 Nonzen elements: 407
Global entities: 23 Global entities: 23
Sets: 1} Sets: 1]
Set members: 1} Set members: 1]
Ovverall status: Finished global search.
LP relaxation: Global gearch:
Algorithm: Simplex dual Current node: 13
Simplex iterations: 9 Depth: I}
Objective: 16.B337 Achive nodes: 0
Status: LF Optimal Best bound: i}
Time: 0= Best salution: i3]
Gap: 0%
Status: Solution is optimal.
Time: 0Bz

Pausing:

Time overheads:
Progreszs graphe:
wiriting output;

Updating status:

01z
0.0z
0.0z
01z

Output/Input | Stats | Matrix | Solutions | Objectil.rel MIP search | BB tree |—
s

During the optimization (solving) stage of a Mosel run, or when optimizing a matrix file, this
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window pane displays the state of the Xpress Optimizer.

Text is highlighted (black) when the status or activity is current or currently taking place. Text is
dimmed (gray) when the status information depicted is no longer current (e.g., when the
optimizer is processing a presolved matrix, the before-presolve matrix is not currently relevant) or
if the activity described is either finished and still relevant (the LP relaxation statistics are useful
during the global search phase) or not started yet.

The Time overheads section shows the approximate time spent by Xpress-IVE on tasks other than
optimization. Note that the time overhead created by other programs (processes) running on the
same machine is not accounted for, even though they can slow down the optimization
significantly.

3.9 The Matrix tab of the Run Bar

m Sketch view : A summarized view of the rows and columns that make up the matrix
m Column view : A list of all columns in the matrix

B Row view : A list of all rows in the matrix

Graphical view : An interactive graphical representation of the matrix contents

m Scaling view : A histogram showing matrix coefficient ranges

3.9.1 The Sketch View

Matrix e

Sketch | Column vlewl Row view | Graphical original I Graphical presolved | Scahng‘

Count Constraints % Variables ~~ buy[16] ~ make (16] o~ openm (8] «— pstock (20) «—~ rstock (200 ~—~  sell(16]
1 "OBJECTIVE* 16 16 g 16 16 16

E Closed 12

8 MuMake 18 g

8 MuRStock 18

8 MuSel 1€

E PBal 18 32 1€

E RBal 16 32 32

=
=

TR

B

Qutput/Input | Stats | Matrix | Solutions | Objective | MIP search I BB treel User graph I s ‘

This view attempts to summarize arrays of constraints and arrays of variables into logical units to
give a more concise representation of the matrix in the Optimizer.
In the example above, the following information can be gleaned about the matrix from the
sketch view:

1. There are 6 rows of type = which are named Closed.
There are 8 rows of type = which are named MxMake.

There are 8 rows of type = which are named MxRStock.

There are 8 rows of type = which are named MxSell.

i A W N

There are 16 rows of type = which are named PBal.
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14.

There are 16 rows of type = which are named RBal.

In ALL the 6 = rows named Closed, variables named openm appear 12 times.

In ALL the 8 = rows named MxMake, variables named make appear 16 times.
In ALL the 8 = rows named MxMake, variables named openm appear 8 times.

In ALL the 16 = rows named PBal, variables named make appear 16 times.

. In ALL the 16 = rows named PBal, variables named pstock appear 32 times.
. In ALL the 16 = rows named PBal, variables named sell appear 16 times.

. The objective function references variables named buy 16 times, variables named make 16

times, variables named openm 8 times, ...

and so on...

Notes:

m Only constraints and variables sent to the Optimizer will be represented.

E In most cases, by examining the names of variables and constraints in the matrix, IVE can

determine their ‘roots’ and implicitly the logical arrays they belong to. Sometimes, however,
the intentions of the user may not be guessed correctly. Please keep in mind these actions
performed by IVE on each variable and constraint name to determine its root:

1. All blanks at the beginning of the name are removed.
2. All blanks at the end of the name are removed.

3. The name is then searched from left to right for any of these letters: "{[(0123456789".
When any such letter is found, that letter and all subsequent letters are thrown away.

4. If the previous three steps produce non-empty name, it is the designated as the root of
the original name.

5. If the previous three steps yield an empty name, start again with the original name and
do the following:

6. Remove all digits ("0123456789") from the name.
7. The remaining letters in the name are designated as the root.

® Some examples:

The root of x[1,2] is x
The root of production_level("Detroit","April",5) is production_level
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3.9.2 The Column View

Matrix

o

Sketch | Column view | Row view | Graphical original | Graphical presol| 4 | *

Colurnn

o o= M M & L ka0

10
1
12
13
14
15
16
17
18

rrtrrrrrrrr et el

Hame

C1
C2
C3
C4
w5}
CE
C7
[
C3
c10
C11
C12
13
C14
C15
C16
c17
13
C13
[T

Rows

L L T I I L R L I e R

LE LE

I ]

0 Te+020

0 T1e+020

0 Te+020

0 Te+020

0 T1e+020
e+l Te+020
de+0..  1e+020
e+l Te+020
e+l Te+020
de+0..  1e+020
e+l Te+020
de+0..  1e+020
Sle+l..  Te+020
e+l Te+020
de+0..  1e+020
e+l Te+020
I ]

0 T1e+020

Solution

0
11.3313
9.014E7
£.05435
3.04569

0

-96.35
134.6E3
197.585
200.546

203.55

0

796.35
B01.631
404.096
203.55

0

0
0.0594413

s

m

k

SLP |Usergraph| s |

Outputf[nputl Stats | Matrix |So|utions | Objectivel MIP =earch | BE tree r

This view lists all variables (columns) in the matrix currently loaded in the Optimizer.

Note:

m Not all variables declared in the model may have been sent to the Optimizer!

m Values are updated as they become available (e.g., if a new integer solution was found, the
values are immediately updated).

The headings are:

1. An icon showing the type of the variable

N o v ~ W N

is valid!

®

LB: The lower bound for the variable

UB: The upper bound for the variable

Column: The column number in the matrix for the current variable
Name: The name of the variable, as understood by Mosel

Rows: The number of rows(constraints) in which the variable participates

Reduced cost: Current reduced cost. See above for validity.

Solution: The current solution value of the variable. Check problem status to see if solution

9. Type: Description of the type of the variable (continuous, binary, integer, semi-continuous,
semi-continuous integer, partial integer)
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3.9.3 The Row View

Matrix e
| Sketch | Column view | Row view Graphical eriginal | Graphical presol * | *
Row Mame  Cols RHS Ativity it
OBJECTIVE® 2B B4 B
< 1] _R1 24 23 B
< 1 _R2 40 ciz] |
< 2 _R3 2 1 1]
< 3 _R4 2 1 I
< 4 _RS 2 1 ]
< 5 _RE 10 ] I
< B _R7 5 5 1]
< 7 _R8 12 1 2
< g _R19 30 23 10
< 9 _R10 12 1 1
< 10 _R11 52 51 10
< 11 _R12 8 7 1
< 12 _R13 5E 55 10
£ 13 _R14 8 7 4
< 14 _R15 4 3 1
< 15 _R1E 5 5 1]
< 16 _Ri17 2 1 I
< 17 _R18 36 35 9 -
4 | 1l 3
Output/Input | Stats | Matrix | Solutions | Objective | MIP search | BB tree r
Usergraph | 1S

This view lists all constraints (rows) in the matrix currently loaded in the Optimizer.

Note:

m Not all constraints declared in the model may have been sent to the Optimizer: only
constraints linked to the Objective function are sent to the Optimizer.

m Values are updated as they become available (e.g., activity values are updated when finding

solutions).

The headings are:

(=Y

W ® N o U B W N

Slack: Its current slack value

Dual: Its current dual value

An icon showing the type of the constraint

Row: The row number in the matrix for the current constraint

Name: The name of the constraint, as understood by Mosel

Cols: The number of variables(columns) with nonzero coefficients in this constraint(row)
RHS: The right hand side of this constraint

Activity: Its current activity value

Type: Description of the type of the constraint (=, =,=, range, free)

Xpress-IVE Toolbars

©Copyright 1983-2014 Fair Isaac Corporation. All rights reserved. page 31



3.9.4 The Graphical View

Matrix

3

Fows

Graphical original | Graphical presolved | Sca * | *

20

I T
0| o of of o =

I |
el

SLP

Output/Input | Stats | Matrix |So\ut\ons | Objective | MIP search | BB tree ’—

User graph s

Use the slider on the left to change the relative size of the two windows.

If the matrix is small (less than a hundred rows and/or columns), each colored rectangle in
the upper part of the window will represent one nonzero coefficient in the matrix.

If the matrix is large or very large (above one thousand and up to hundreds of thousands of
rows and/or columns), a colored rectangle will represent a region in the matrix,
corresponding to a certain number of rows and columns. All the nonzero coefficients in the
matrix (regardless of its size) are examined; only those regions that have at least one
nonzero coefficient will be represented by a colored rectangle.

The matrix can be zoomed into by clicking and holding the left mouse button and dragging
right and down. After zooming, only the region marked by the zooming rectangle will be
shown. The coefficients are recounted and the accuracy of the display will increase. After
zooming deep in the matrix, a point can be reached where the colored rectangles represent
actual coefficients in the matrix. When the current view is the result of a zoom one can
move around the matrix by dragging with the right mouse button.

To zoom out, double-click the left mouse button.

The rectangle shown permanently next to the cursor acts as a magnifying glass. It marks a
region consisting of 12 rows and 10 columns next to the cursor and brings that region into
view in the lower part of the window. As the mouse cursor moves around in the matrix, the
magnified region is constanly updated.

The meaning of colors:

— Red — A negative coefficient or a region where all coefficients are negative.

- Blue — A positive coefficient or a region where all coefficients are positive.

— Purple — A region where some coefficients are positive and some coefficients are
negative. The shade of purple indicates the predominance of either.

In the magnified 12 x 10 region, the names of the rows (constraints) and columns (variables)
are shown (to enable the actual names used in the Mosel model, set the "mmxprs" boolean
parameter XPRS_LOADNAMIES to true).

At the top, following a comma after each column number is the type of variable:
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C — indicates a continuous variable;

| — indicates an integer variables;

B — indicates a binary variable;

S — indicates a semi-continuous variable;

R — indicates a semi-continuous integer variable;

P — indicates a partial integer variable.
On the right hand side, the type of constraint is shown. Note that <and >are used instead of

the actual < or >, to improve readability. In the case of a non-binding constraint, the

character '*' is shown.

3.9.5 The Scaling View

3.10

Sketch || Column view | Row view | Graphical original Graph\calpreso\ved‘ SCG|‘HQ|

Original
Minirum: - Ze-006
M awimurn: 1e+020

MNumber of coefficients in range
[1e20,1e21) 207
[1e19.1e20]
[1e18.1e19]
[1e17.1e18]
[1e16.1e17)
[1e15.1&16)
[1e14.1215]
[1e137e14]
[1e12.1e13]
[1e11.1e12]
[e10.1e11]

[1e9,1e10]

[1e8.1e9]
[Ted.1ed)
[TeE1e7]
[Te5.1eb)
[Ted.1eh]
[1e31ed]
[Te2.1e3]
[Tel.1e2]
[1e0.1e]]
[Te1.1e0]

[1e-2.1e1]

[Te-31e2]

[1e-4183)

[Te-0led]

[1e-E1eb]
[1e-7.1e6]
[le-B1e7]
[1e-31e8]

[1e-10.129)
[e-11.1e10]
[e12.1e11]
[1e13.1e12]
[le14.1e13)
[1e15.1e14]

1

0 2 3 4 5 E
o 10 10 10 10 10 10

Include: tatrix coefficients Right hand sides Ojective coefficients Bounds

Prezolved
Mirirum: - Se-006
M auimur: 1e+020

Nurnber of caefficients in range
[1820,1e21] 1969
[1e13.1e20]
[1e18.1219]
[1e17.1e18]
[1e16.1217]
[1e15.1e16]
[1e14.1215]
[1e131e14]
[1e12.1e13]
[1e11.1e12]
[1e10.1e11]

[1e9,1e10]

[1e8,1e3]

[1e7.1e8]

[1eE.1e7]

[1e5.1e6]

[1ed,1e5) ] 42

[1e31ed)

[1e2123)11

[1e1.1e2]

[1e0.1el]
[1e1.1e0]
[1e-2.1e-1]
[le-31e2]
[1e-416-3)
[le-5.1e-4]
[1e-E.1e5]
[1e-7.1eE]
[le-f1e7]
[1e-316-8)

[1e-10.1e-9]
[1e-11.1e-10]
[le-12.1e11]
[1e131812)
[1e-14.1e13)
[1e-15.1e-14]

i}

0 10 1010 10 10

Output/input | Stats ‘ I atrive ‘Dbieclive MIF search | BE tree

A histogram showing ranges for matrix coefficients, right hand sides, objective coefficients, and

bounds.

The Objective tab of the Run Bar

The graph on top shows the evolution in time of the objective value during the Simplex

algorithm. The iteration is also plotted by time.
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Objective

Click for graph histony

Simplex Objective variation

T |v —+ Objective
‘ [~ —+ lteration
2 I
= ' =
8 : =
o= B =
S B e EEEEEEt: O | 8
N R -
- o
o 1
Time
=
Duality gap

[v —+ Duality gap

Output/Input | Stats I Matrix I Solutions| Objective | MIP search | BB tree|—
SLP | User graph | s |

The graph at the bottom shows the evolution in time of the duality gap during the Newton
barrier algorithm.

1

Ohbjective
Click for graph history v]
Simplex Objective variation
W —+ Cbiective
[~ =+ heration
(=]

Duality gap

I¥ —+ Duality gap I

Duality gap
CooooDooom~
i ha b Bin o S ok

01 02
Time:

=\|||||\||\

Outputﬂnputl Stats I M atrix | Su\ut\un;‘ Objective |IVIIP search | EB treal s |

m At any time, only one of these progress graphs can be active (corresponding to the
algorithm currently running).

m The graphs can be zoomed in and out and each curve can be shown or hidden using the
checkboxes in the graph legend.
m Use the slider bar to change the vertical size of either graph.

m Xpress-IVE maintains a history of the last ten graphs produced. Select the desired graph
from the list at the top. Note that the graph history cannot be accessed during an

optimization.
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3.11 The MIP search tab of the Run Bar

MIP search b

Click for graph higtom -

[ =+ Gap
|w @ Integer solution
WV & Depth

0 01 02 03 04 05 06 07 08

ime

= [Accept current best solution and continue ]

MIP Objective

[w —~+ Best salution
@] |¥ ~+ Best bound
: "IV @ Integer solutions

g

Objective

]

0 01 02 03 04 05 06 07 08
Time

Output/Input | Stats | Matrix I Solutions | Objective| MIP search | BB tree |—
s

The graph on top shows the evolution in time of the MIP gap during the global search. Also
shown are the points where the integer solutions were found and the depth in the search tree at
which each solution was found.

The graph below shows the progress of the current best integer solution objective relative to the
best bound. Integer solutions are marked as well.

m The graphs can be zoomed in and out and each curve can be shown or hidden using the
checkboxes in the graph legend.

m Use the slider bar to change the vertical size of either graph.

m Pressing the button "Accept current best solution and continue" will terminate the MIP
search but the execution of the Mosel model will continue. This behavior is unlike that of
the Stop button, which stops the entire model.

m Xpress-IVE maintains a history of the last ten graphs produced. Select the desired graph
from the list at the top. Note that the graph history cannot be accessed during an
optimization.
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3.12

The BB tree tab of the Run Bar

When paused, highlight nodes branching on

Output/Input | Stats | Matrix | Solutions | Objective | MIP search | BBtree | 1S

The Branch and Bound tree is a representation of the search for an integer solution when
optimizing MIP problems. To enable/disable drawing the BB tree use the Run Options dialog.

Notes:

m The tree is displayed for Mosel as well as Optimizer runs and it is updated continuously

during the MIP search (to enable the names used in the Mosel model to appear in the tree,
set the "mmxprs" boolean parameter XPRS_LOADNAMES to true).

White nodes are either still active or in-tree.
Red nodes are infeasible.
Yellow nodes are cut off.

The 20 most recent nodes are in decaying shades of blue, with bright blue being the most
recent.

The green nodes represent solutions. The best solution so far is green and large. The
brighter the color, the more recent the solution.

When hovering the mouse above a green solution node, a number will appear next to all
solution nodes, indicating the order in which the solutions were found.

If fewer than 5000 nodes have been visited so far, the entire tree will be drawn (see above).

If more than 5000 nodes have been visited, only nodes up to a depth of 10 will be drawn
fully. The rest of the tree is summarized by scattered dots (which will turn into real nodes
when zooming). Solutions and the 20 most recent nodes (in blue) are displayed regardless
of their depth:
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‘when paused, highlioht nodes branching on

E Zoom in by holding the left mouse button down, dragging right and down and releasing it.
A rectangle will indicate the area to be zoomed.

m Return to full tree view by clicking the left mouse button when zoomed.

m When zoomed, the lower left corner shows a scheme of the entire tree, while the
"porthole" (representing the area seen in the main tree window) is highlighted:

‘Wher paused, Highlight nodes branching an
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m To move around in the tree when zoomed, hold the right mouse button down and drag in
any direction. The small preview window in the corner will continuously reflect the new
position in the tree.

m The arrow keys will also move around in the tree (ensure the tree window has the focus by
right-clicking in it - do not left click — that will return to full tree view).

m If lost in the tree or if the image doesn’t look correct, left click to return to full view.

m Hovering the mouse above nodes will produce tooltips with information on the current
node.

m The tooltips at each non-terminal node contain the following information:
— Node number
— Depth
— Initial branching direction
— The branching variable and its current relaxed solution value
— Relaxed objective
— Current best bound
— Current best solution
— Number of descendants
— How many descendants are cutoff, infeasible, solutions

— The ten most recent ancestors of the node, each with info on branching direction
BB tree 2

When paused. highlight nodes branching on | - |

NN
i 2
!

Mode 64, Depth: 4, first branches DOWN on x16=0.27512

“;.-_:3"'

J\ Estimated degradation: 0
Relaxed objective: 28.315

A Current best bound: 26,8141
Current best solution: 37

ﬂ 8 descendants: 3 cuteff, 1 infeasible, 0 solution(s).

Predecessors:
Model, Depth: 0, DOWN on x17=0
MNode 3, Depth: 1, DOWN on x10=05

Mode 61, Depth: 2, UP on x3=0.128501
Mede 62, Depth: 3, UP on x18=0.388283

Y
|
A ﬂ

OQutput/Input | Stats | Matrix | Selutions | Objective | MIP search | BB tree
s

m Double click on a node to obtain a listing of all of its ancestors (shown in the View text
dialog).

m When the optimization is complete, paused or stopped, search for specific branching
variables in the tree using the tree highlighter tool (can be enabled/disabled from the Run
Options dialog): just select a variable name from the drop list and all visible nodes
branching on that variable will begin to flash in alternating blue and yellow.
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m To stop highlighting, select the first item in the highlighter tool droplist: the blank.
m While there is no limit on the size of the displayed tree, if the tree is very large (e.g. over
200,000 nodes on a PllIl 800Mhz machine), it will react slowly to user actions.

3.12.1 Parallel branch and bound trees

Note that each branch is colored according to the thread that processed the node. Shown below
are trees obtained with 2, 4, and 8 threads.

2 threads 4 threads
L

‘wihen pauzed, highlight nodes branching on [ -|

‘when paused, highlight nades branching on |} L.

Output/nput | Stats | Matri | Soutions | Objectve | M search | B8 tree

Output/input | Stats | Matr | Solutions | Objective | MIP search | B8 ree
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8 threads
eBgee . ®

‘when paused, highlight nades branching on %}i

Output/input | Stats | Matri | Solutions | Objectve | MIP search | 86 tres
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3.13 The SLP search tab of the Run Bar

SLP 2

SLP: Unconverged variables
8

| [v* == Unconverged variables I

(S - B |
|

o
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|
h
|
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|
.
|
|

4
\
.
|
|
|
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Unconverged variables
T

%]

=
|
'
'
'
'
'
soofpos
'
'
'
'
'
L
'
'
'
'
'
=

=

%]

Objective

MIP search | BE tree| SLP | User graph | s |
Outputf[nputl Stats I Matrix | Solutionsl Objective|

The graph at the top shows the evolution in time of the number of unconverged variables during
the SLP run. A sample is taken at each SLP iteration.

The graph at the bottom shows the progress of the current best objective. A sample is taken at
each SLP iteration.

m The graphs can be zoomed in and out and each curve can be shown or hidden using the
checkboxes in the graph legend.

Xpress-IVE Toolbars ©Copyright 1983-2014 Fair Isaac Corporation. All rights reserved. page 41



3.14 The User graph tab of the Run Bar

User graph B

Click far graph history v]

¥ W Network
[V B Used routes

100

50

80

70

60

50

40

30

20

.
] 100
Output/Input | Stats I Matrix | Solutions | ObJectlvel MIP search I BB tree| User graph
1s

This window offers the opportunity to plot points on an unlimited two-dimensional grid when
using the "mmive" Mosel library. The graph is automatically scaled to include all and only the
plotted points. There is no limit on the number of items that can be plotted.

The "mmive" module in Mosel contains these functions and procedures:

procedure IVEpause( message: string) Pausesthe Mosel execution atthe line where it
was called. It also prints a message at the top of the Run Bar that may inform the
user of the reason for pausing. While the execution is paused, model entities can
be examined in the entity tree, or the user graph may be inspected in slow motion.

function IVE_RGB( red: integer, green: integer, blue: integer): integer
Compute a composite color by combining amounts of red, green and blue.

function IVEaddplot (name:string, color:integer): integer Insertsa new ploton
the user graph. A plot is indentified by its name and can be shown or hidden using
its corresponding legend checkbox. The maximum number of distinct plots is
currently limited to 20. However, each plot can contain an unlimited number of
points, lines, arrows and labels. In the graph above, both "first fractal" and
"second fractal" are plots. They can be shown/hidden using the checkboxes in the
legend.

procedure IVEdrawarrow (handle:integer, xl:real, yl:real, x2:real, y2:real)
Add an arrow to an existing plot. The arrow connects the two points whose
coordinates are given as parameters, pointing to the second one.

procedure IVEdrawlabel (handle:integer, x:real, y:real, text:string) Adda
text box to an existing plot. The box will be centered horizontally just above the
point given.

procedure IVEdrawline (handle:integer, xl:real, yl:real, x2:real, y2:real)
Add a line to an existing plot. The line connects the two points whose coordinates
are given as parameters.

procedure IVEdrawpoint (handle:integer, x:real, y:real) Add asmallsquare to
mark a point at the given coordinates.
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procedure IVEerase Remove all plots and reset the user graph.

procedure IVEzoom(xl:real, yl:real, x2:real, y2:real) Scalesthe user graph. The
viewable area is determined by its lower left and upper right corners.
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CHAPTER 4

Xpress-IVE Dialogs

4.1 Optimizer Dialog

Accessible by selecting Optimize matrix file... from the Optimizer menu or by clicking the

—9‘1/ ._.:2,-1'*/ "l buttons on the Toolbar.
b atrict filename: —
[7] Load directives file [<flenames. dir] Solution optians

[ Load salution file [<flenames.sk) @ Find best sclution () Find 5

best solutions

Algarithm Senze Optimization [] Analyze if infeasible
) Primal @ Minimize () Relawed [LP.OF) [T] REPAIR/Relax if infeasible Start

() Dual () Manimize @ Perform global search [MIF, MIGP) [¥] wiite solution summary to sereen

@ Barrier () NONE - only Ioad matiix [ wafrite solution to formatted ASC file I'VE Options... | B
() Metwark, Apply optional contral parameters to this run...

Parameters [F1 for Help] T
ACTIVESET -
ALGAFT EHCHDSS[‘—‘

AUTOPERTURE
BACKTRALCK
BACKTRACKTIE
BARCRASH
BARDUALSTOP
BARGAPSTOP
BARINDEFLIMIT
BARITERLIMIT
BARORDER
BAROUTPUT
BARPRESOLVEDP!
BARPRIMALSTOP
BARSOLUTION
BARSTART
BARSTEPSTOP
BARTHREADS
BIGHM
BIGMMETHOD
BRAMCHCHOICE
ERAMCHDIS]
ERANCHSTRUCTU
BREADTHFIRST -
CACHESIZE i

m

The Optimizer dialog allows the optimization of a matrix file (MPS or LP format). After the
various settings have been set, the Start button will proceed with the optimization. Up to five
different strategies may be ‘checked’. IVE will run the strategies successively and display the
progress log in the Output window. To compare the relative performance of different control
parameter settings visually, look at the histories of the MIP search graphs.

Options:

Xpress IVE
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4.1.1 Load directives file

Perform the branch and bound search according to an Optimizer 'directives’ file. Please check the
Optimizer reference manual for more information on directives and how to set them.

4.1.2 Load solution file

Loads an .slx solution file prior to solving an MIP problem. Please check the Optimizer reference
manual for more information on .slx solution files.

4.1.3 Algorithm

Primal
Dual
Barrier

Network

4.1.4 Sense

Simplex primal.
Simplex dual.
Newton barrier interior point.

Network.

Note that this setting will override the sense specified in the LP file. Make sure the correct sense

is selected.
Minimize
Maximize

4.1.5 Optimization

Relaxed
Perform global search

NONE - only load matrix

4.1.6 Solution options

Find best solution

Find N best solutions

Analyze if infeasible

REPAIR/Relax if infeasible

Minimize the objective function

Maximize the objective function

Find a relaxed solution
Find integer solutions

Loads the matrix for visualization/inspection. No optimization is
performed.

For MIP problems: runs the Optimizer to find the optimal solution.

For MIP problems: runs the Optimizer in a special mode to find
alternate optimal solutions. (Note that the BB tree visualization will
no longer be accurate)

If problem is infeasible, run the 1IS Optimizer command to examine
infeasibility sets.

Attemps to find a feasible solution to an infeasible problem by
relaxing constraints and bounds. For more information look up the
command REPAIRINFEAS in the Optimizer Reference Manual.

Write solution summary to screen Write nonzero variable values from the solution vector to the

Output window in the Run Bar.

Write solution to formatted ASCII file Write the solution to a .prt file and open it for viewing.

Xpress-IVE Dialogs
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4.1.7 Strategies (control parameter settings)

Set these control parameters before the matrix is read in.
For example:

VARSELECTION=3 MIPRELSTOP=0.05

4.2 View text Dialog

c . ECEEETTSSS—S—S—S—S—_—_-_-_--- 19
Text view | Table view I

C({"SABORO22™)=Scluticn: 1, Reduced coat: 0 -
C("SABIY00&™)=Scluticn: 1, Reduced cost: 0
C({"SANDR141")=Scluticn: 1, Reduced cost: -13400.4
C({"SHELY00&6")=Scluticn: 1, Reduced cost:
C("5TaMR141")=5clution: 1, Reduced cost:
C("TAUQX004")=5clution: 1, Reduced cost:
C("TAUSY006™)=Sclution: 1, Reduced cost:
C("TEM0OX004™)=Scluticn: 1, Reduced ecost:

1

1

1

1

1

1

.32831e-010
C({"TEM9X004™)=Sclution: 1, Reduced cost:
C({"TOPOY00&")=Sclution: 1, Reduced cost:
C{"TOPSY006™)=Scluticn: 1, Reduced cost:
C("TRANA141™)=Scluticn: 1, Reduced cost: 0
C("VANOY00&™)=3clution: 1, Reduced cost: 5.82077e-011
C("VAN9A0E81")=5clution: 1, Reduced cost: -1982.51
C("XTROX004™)=Sclution: 0.754142, Reduced cost: 0O
C{"XIR0OZ0OO0T7")=Sclution: 0.2458528, Reduced cosat: O
C({"XTR9Z007")=Scluticn: 1, Reduced cocst: 0
C{"YPS5IX004")=Scluticn: 1, Reduced cost: -0.19945%
{with 2902 zeroc-wvalue element({s) hidden)

[ N = )

4 i

L3
Co
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c . h . W =
Table view

{"} COLNAMES [1cC

"9L0ATET 0903744
"9L0a191t 0090256
"9L34151"  0.594041
"9L3AT61" 0.405959
"2AL0ATEZY 1
"23LeA1E2"
48004141
48034121
"49L04031"
49194192
"BOL0ATTT"
"BOL9ATTT"
"AGLSYO0E!
"ALTCYO0E"
"Asy0a0sT" 1
"ASyVgA08T" 0714
UASYWIADST" 0057523
UASYIAI0T" 0220477

| »

m

_ e

"aKLEATIT" 1
"BIROVOOE" 1
"BIRSvO0E" 1
"BR204061" 1
"BR29v00E" 1
"BROOAT07" 1

"BROSATI  0.928743
"BROSATIZ1"  0.0712511
"COCLZ007" 1 |

The View text dialog can be used to display in simple editable format:

m The value of an entity in the Entity tree, by double clicking the entity. This is where the full
listing of an array or set can be examined.

m The value of an entity in the editor window, by bringing up the context menu and selecting
Show value of.... This only applies to non-scalar entities, such as arrays and sets.

m The complete list of ancestors for a node in the branch and bound tree pane in the Run Bar,
after double clicking the node.

The contents of either the text view or the table view can be saved (as plain text or as CSV
respectively) or copied to the clipboard via the context menu on each control. The text menu
further offers facility for full cut-and-paste, and text search.

There is one control to affect display of data: The Hide zero-value decision variables checkbox
will, when checked, remove those elements from a collection of mpvar for which the Mosel
getsol function returns zero.

4.3 Run options Dialog

Accessible by selecting Options... from the Build menu or by clicking the ng' button on the
Toolbar.
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Draw progress graphs Pauze Matrix vizualization

[ Simplex [7] At every Simplex log entry [T] Show original matris
[7] Newton barrier [] &t every Newton barier log entry 7] Show presahved matris

O Globl}earch [] &t every Global search log entry

Stachastic models
[T Pause to prune scenario tree manually @

Eranch and Bound tree CP search tree [max 131,072 nodes)

[ Enable sketch view
[ Enable thumbnail views

LAY
Diraw CF zearch tree \/ by

1

Diraw tree LA
( N,

Enable node highlighting A Store all domains forup to (100 | nodes.

Usze Maodel parameaters (e.g. paraml=valuel paramzZ=valusZ etc.]:

Default PROJECTDIR:  Chiobs

Parameters D& TAFILE='data. bat!

[ Apply ] [ Cancel ]

Settings that control the execution of a Mosel model or the optimization of a matrix file can be
modified using this dialog. This dialog can be invoked at any time, even while a run is taking
place. Changes will take effect immediately after the dialog is dismissed.

Options:

4.3.1 Draw progress graphs

Simplex Graph the progress of the Simplex algorithm. The sampling is made
every second.

Newton barrier Graph the progress of the Newton barrier algorithm.

Global search Graph the progress of the global search for integer solutions. The
sampling is made every second.

4.3.2 Branch and bound tree
Draw tree Draw the Branch and Bound tree.

Enable node highlighting Allow searching for nodes in the tree by variable name.

4.3.3 Pause

At every Simplex log entry  Pause at every log entry during the Simplex algorithm. Log entries
are produced periodically during the course of the Simplex
algorithm; their frequency is controlled by the "mmxprs" parameter

XPRS_LPLOG.

At every Newton barrier log entry Pause at every iteration during the Newton barrier
algorithm.

At every Global search log entry Pause at every log entry during the global search for integer
solutions. The frequency with which log entries are generated
during the global search is controlled by the "mmxprs" parameter

XPRS_MIPLOG.
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4.3.4 Matrix Visualization
Show original matrix After a problem is loaded in the Optimizer, its matrix can be

examined. Select this option to make a copy of the matrix and
visualize it.

Show presolved matrix After a problem is '‘presolved’ by the Optimizer, the matrix will most
likely have changed. Select this option to examine the presolved
matrix.

4.3.5 Stochastic models

(if available)

Pause to prune scenario tree manually When developing a stochastic model, use this option to
pause the Mosel run just before solving the stochastic problem.
When the model is paused, scenarios can be aggregated or deleted
in the scenario tree.

4.3.6 Constraint programming models

(if available)

Draw CP search tree Draw the CP search tree.

Store all domains for up to nnnn nodes Maintains detailed variable domain information for the
first nnnn nodes.

4.3.7 Use Model parameters
If the Mosel model has declared one or more parameters, they can be overriden. Select this

option and then specify the parameter values to be used during the execution. Any number of
parameters may be omitted: only those specified will modify the default parameter values.

4.3.8 Default PROJECTDIR

If a Project is loaded, this will be set by default to the directory in which the Project is located.

4.3.9 Parameters

A sequence of assignments, in name=value, name2=value... format, specifying names and
values to be passed to the parameters ... end-parameters block of a Mosel model when it
runs.

4.4 Debug options Dialog

Accessible by selecting Debug Options... from the Debug menu or by clicking the ﬁ button on
the Toolbar.
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Debugging options ﬁ ﬁ

Breakpoints

() "Saft" breakpoints - output watches, then continue

@ "Hard" breakpoints - wait for user to continue

‘when debugger stops at a line:
() Mo output
() Dutput line number

() Output line number + line content

Also
[ Dutput watches

[ Apply ] [ Cancel ]

This dialog contains settings that control the behavior of the debugger.
Options:

4.4.1 Breakpoints

"Soft" breakpoints When reaching a soft breakpoint, perform any of the actions below

and then continue. This helps in gathering a log of the model
execution without user intervention.
"Hard" breakpoints When reaching a hard breakpoint, watches are updated and the
execution stops. The execution must be resumed manually.

4.4.2 When debugger stops

The following options are available:

No Output
Output line number
Output line number + line content

Output line number + line content + expand identifiers
Output watches

See some typical debugger output for more information.

4.5 Breakpoint condition Dialog

Accessible by selecting Set/Remove Breakpoint condition... from the Debug menu or by clicking
the &7 button on the Toolbar.

Breakpoint condition . i ﬁ
Ereak at thiz line when:
Identifier, e.g.; i Walue, e.0.0 100
bup(product,3) "'ztring_walug"
alk.s] true
] Cancel

This dialog allows setting a conditional breakpoint.
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The conditional breakpoint will activate only when the condition is met.
4.6 Export to matrix Dialog

Accessible by selecting Export Matrix... from the Build menu or by clicking the -Ij button on the

Toolbar.
Export problem to matrix file ﬁ

Farmat ) ;
) o Mame of linear constraint
(@) LP format, minimization representing objective function:
() LP format, maximization [Eost v]
(71 MPS format

I [7] Scramble names

After the Mosel run completes successfully, a standard matrix file (MPS or LP) can be exported
using this dialog.

The objective function in the matrix file is determined by the linear constraint entity specified.
Consequently, the objective must have been declared as a linear constraint variable in the Mosel
model.

The column and row names can be scrambled to hide the original entity names from the model.

4.7 Deploy Dialog

Accessible by selecting Deploy... from the Deploy menu or by clicking the = button on the
Toolbar.

If you wish to build a model as an executable file, see the Self Executing Model Dialog.

The candidate file for deployment is:

C:\jobs\papers.maoz

How would wou like to use this Moszel model in your application’?

Save .BIM file Run Moszel model fram Optirnize matrix file fram

@c C
) All namnes stipped @ Java Java
(70 Wisual Basic Wisual Basic
) WB.MET WBLMET
O CH Ct

To directly create a"Windows executable that runs a BIM file, please uze the
Self Executing Model dialog from the Deploy menu

This dialog is the first step in deploying a mosel model or a matrix file in a user application
written in C/C++, Java or VB. After selecting how the current file will be deployed, click on "Next
>" to preview and save the generated code.

Choices:
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Save .BIM file (with debug information) The .BIM file will contain all original strings plus debug
information.

Save .BIM file (all names stripped) Secure the .BIM file by removing human-readable identifier
names.

Run Mosel model from C Only available when a .mos file is open in the editor. Produces a
simple C program.

Run Mosel model from Java Only available when a .mos file is open in the editor. Produces a
simple Java program.

Run Mosel model from Visual Basic Only available when a .mos file is open in the editor.
Produces a simple VB program.

Run Mosel model from VB.NET Only available when a .mos file is open in the editor. Produces a
simple VB.NET program.

Run Mosel model from C# Only available when a .mos file is open in the editor. Produces a
simple C# program.

Optimize matrix file from C Only available when a matrix file is open in the editor. Produces a
simple C program.

Optimize matrix file from Java Only available when a matrix file is open in the editor. Produces
a simple Java program.

Optimize matrix file from Visual Basic Only available when a matrix file is open in the editor.
Produces a simple VB program.

Optimize matrix file from VB.NET Only available when a matrix file is open in the editor.
Produces a simple VB.NET program.

Optimize matrix file from C# Only available when a matrix file is open in the editor. Produces a
simple C# program.

4.8 Self-Executing Model Dialog

Accessible by selecting Self-Executing Model... from the Deploy menu or by clicking the “&*
button on the Toolbar.

Xpress-IVE Dialogs ©Copyright 1983-2014 Fair Isaac Corporation. All rights reserved. page 52



Choose a name (default is the Mosel model name) and save location for the self-executing Mosel
model. If more than one system is chosen then each EXE will be created with the system name
incorporated in to the file name.

Executable Mame:  MyModel

Save Location: C:\jobs

Create For: Win32 Linux32
Win64 Linuxa4

Solaris SPARC32 HPUX32 AIX3Z

HPUXG4 [ ] ATX64

n 1464 [ |Linux IA64 HPUX TAG4

Self executing model created as: C:\jobs\MyModel_win32.exe.
Self executing model created as: C:\jobs \MyModel_wing4.exe.

[ Finished ] [ Create ]

This dialog can be used to create executables with self-contained compiled Mosel models within
them.

The dialog contains the following options:

m Executable Name: The name of the executable to create. The file used to create the
self-running model will be the Mosel file currently in focus in the editor. Executables are
created using a concatenation of this name and the platform.

m Save Location: The folder location to attempt to save any created executables to.

m Create For: Any platforms for which IVE finds suitable executable stubs for will be
selectable. New executable stubs will be added over time and should be available from the
Xpress website. Currently there are only Windows stubs available. Any stub executables
(named SelfRunMosel_platform.exe) should be placed in the
"% XPRESSDIR %\ bin\Tools_SRAssist" folder.

m Message Output: Any error messages or notifications concerning the executable creation
are displayed here.

m Finished: Exit the dialog.

m Create: Click this to have IVE attempt to build and create the executable for the selected
platforms.

4.9 List Modules Dialog

Accessible by selecting List available modules... from the Modules menu or by clicking the
button on the Toolbar.
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Module 'mmxprs" containg 104 constants, 136 subroutines, 3 types, 16 operators, 214 controls, 010 drivers.

Mame Wersion
" kaliz 10.3.287 Constants | Functions & PTDCEdUTES| Types | Operators | Control parameters | 10 Drivers|
5 :zit: ::2101 Subroutine name Parameters Retumns o
% rmive (IVEN 21,1 " getname (B mprvar) stiing
V mmjobs 111 i getprobstat integer
‘V il 1.21 Te getrange [&: integer, B: mpvar) real
22 mmoci invald TE getrange [ integer, B: linctr) real |E|
£ mmodbe 210 % getright i lagetr) logctr e
3 mmauad 125 & getsensmg [&: integer, B: mpvar) real
B mmaystern 170 e getsensmg [&: integer, B: linctr) real
B mmead 12.4 i gettype & logetr] integer
3 mimwemd 173 e getub [ mpear) real
] 21.0 \:" gety [ logct) mpvar
LR — 173 E implies [ linetr, B: linctr) lagctr
% impliez [&: logch, B: linctr) logetr
5‘. implies [&: linctr, B: logetr) logete
5. implies [&: logctr, B logetr) loge:tr
5‘. indicator [&: integer, B: mpvar, C: linctr] loge:tr &

Lists the contents (constants, subroutines, operators, types and control parameters) of Mosel
dynamic modules that are currently available to Mosel. Please refer to the Mosel documentation
for more information on what modules are.

m Select a module name from the list on the left and then browse through its contents using
the tabs on the right.
m A green check next to a module name indicate that it was successfully loaded by Mosel.

m A green check with a Dash Optimization logo indicates a module which is part of the Xpress
package.

m Two red question marks next to a module name indicate that even though a .dso file exists,
it could not be loaded by Mosel.

4.10 New Module Wizard Dialog

Accessible by selecting Create a new module... from the Modules menu or by clicking the -
button on the Toolbar.

floctielane Yersion I} Module Contents [persistent across ung of [VE]
ol L - W Conglants
¥ Functions & Procedures
Constants | Functions & Procedures | Types I Contral | ¥ Types
Retum type Procedure name ¥ Control Parameters

Construct parameter list, one at a time
Parameter name: Parameter type:

Parameter preview:

Add parameter
v

Mosel-style preview of subrotine: Add subroutine —>
[unct\on {): boolean

Edit the contents of a virtual .dso module (constants, subroutines, types and control parameters),
then generate the template source code for producing the module.
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m Name the module and specify version numbers.

® Add some constants:
Module wizard

| n] ) o . o W Constants

VY Functions & Procedures
Y Types

¥ Control Parameters

Constants | Functions & F‘rocedu'&sl Types I Cortrol

Type

>

Name Value

T () Boolean

Add Constant —>

Mote: A constant is a scalar whose value cannot be changed.

I Module name Version Madule Contents (persistent across rung of IVE]

® Add some subroutines:

Construct parameter list, one at a time
Parameter name: Paramester type: | -
"ammeter preview:

| Add parameter
v

Mosel-style preview of subroutine: | Add subroutine —> |
r'undi(m (): boolean

Module wizard
I Moduleame  Wersion I} WModule Contents [persistent across runs of IVE]
00 Je Y Canstants
¥ Functions & Procedures
Functions & Procedures | Types | Control ¥ Types
Retum type Procedure name - % Control Parameters

m Add some types:

Module wizard

+ ¥ Constants

Y Functions & Procedures
V Types

¥ Control Parameters

oo

| Constants [ Functions & Procedures | TvEs | Control

MName of the new type

Create

Notes If the box "Create” is checked, the wizard will generate functions
to define the new type.
If the box is not checked. the generated program will assume
that the type is declared elsewhere (2.g. in another module).

In either case, the newly added type will be available to use
in subrouting and operator declarations.

l Module name Version Madule Contents (persistent across runs of IVE]

m Add some control parameters:
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Module name Yersion
oo 0

Type Mame

[F] Read only

Description

Mote: Cortrol parameters can be used to store/retrieve module state
information

Constants | Functions & Procedures | Types | Control parameters

Add Control —>

Module Contents [persistent across rung of VE]

———
it =

- ¥ Constants

Y Functions & Procedures
Y Types

¥ Control Parameters

m At any time, clicking on View code... will show the Source code dialog with the code
generated for the current contents of the module.

m When satisfied with the contents of the module, save the code that is produced and fill in

4.11 So

the functionality.

urce code Dialog

Shown after completing the steps required by the Deploy or the New Module Wizard dialogs.

Compile and run NES;El model from Java

Sample use:

javac -clazspath . ZPRESSDIRZEMbAprm.jar Bunt odel java

java -classpath . %<PRES SDIR %\ibwprm.jar Runtodel

=5

i

4

I-’,-"Java

import java.io.=®;
import com.dashoptimization.*;

puklic class RunModel

public static woid main(String[] args)
{

int result;

try {
result=runMoselModel () ;
System.out.println("Model execution returned:

code generated by the Xpress-IVE deployment wizard

"iresult) )
}

catch (XPEMLicenseError &)

{
System.out.println("Failed to licence Mosel

[ 1 |

: "+ e.getMessage()):

This dialog is the last step in any Xpress-IVE operation that produces C, Java, VB, VB.NET or C#

source code. Depending on what type of source code was produced, compilation instructions are
given. Save the contents of the editor using the Save As... button.

Xpress-IVE Dialogs
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CHAPTER 5

Xpress-IVE Wizards

Wizards can be used to learn more about Mosel, simplify repetitive tasks when developing
models and/or provide insight into the more advanced features of the Mosel modeling language
and the Optimizer.

The general structure of each wizard window is:

m 4
Thmaulgm -
T — = ki

v
VM Bl P i, bl

¥ mah pu g
e S b =T
e

[ L e o

[FRTS o . gy &
L
b Paspea i mmees b s e n

£

1. Wizard selector: at any moment, select the desired wizard from here. Skip any number of
steps, focus on only one wizard, etc.

2. Actual wizard: this part is specific to each of the current 12 wizards.

3. Mosel source: source code produced while interacting with the wizard. This code can be
edited, inserted in the Mosel editor or copy/pasted.

Wizards are designed to be self explanatory and highly interactive. Use the mouse to select
options and watch how the Mosel source code is updated for the current task. Interacting with
the wizards is the only way to assess the practicality of using a wizard for a task. Selecting options
in the wizards is entirely harmless and reversible. No changes are made to your main Mosel
model without explicit approval (e.g., pressing the Insert at cursor button, which adds the
wizard-generated code to the Mosel model opened in the editor).

Select a wizard below for more information:

m 1. Name & Type Wizard
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1.Hame & Type:

Modslname:  ModelName no blarnks)

Type of model: ) LP (pure finear pragramming)

2.Parameters

IDatalnput IF {integer o mixed integer programming)
4V ariables ) OF (quadratic programming)

5.0bjective IGP (mixed integer quadiatic piogramming]
€ Constraints

LP fnaniinear programming using sequential inear programring)

7 Resuls & funin
= ) SP [stochastic programming)

€ Test Output

9 Graphing P [conshaint programming)
10 Prograraming etc.
11 Debugging ) Mo mathematical programming features

12.Complete models
Use graphing and drawing faciities in IVE

Use ODEC for data inputfoutput from databases or spread
Requie statement termination with :

Requite all symbols to be declared before use

Mosel previews

et e e e S S e A

model ModelNane
options noimplicit
uses “mmxprs", "mmive", "rmodbc”

loptional parameters section
!

writeln("Begin running model")
]
writeln("End running model")

end-model =2

2. Parameters Wizard

Masel assistant J scratch
2 Paamalore
2 A — -
[y par
ing the madel. = g~
1 Heeme i T
hatel PRunmod|modal et MAHT IME=S00USE_LOG=tnse']):
q:va-,:tz:" masel ¢ "swec modelmos MEHTIME <300 USE_LDGaine™
Froinmn These vihies sl overide the val Sedinth P
7 Resdis & luning.
g.amqmnm
| Giraphira Motes:  Th Iopeis i "
110 Frogramming efc. o L e
11 Debuzorg of & medel
T2iComplits madels Paameters are treated  Theis vl (ot
Farameter types:
Boclan: bue o falze
Inlege Anistedes between 2147 AZ3E4E and 2,147,483 547
Flesal & raamber betweesse: -1 Ten 208 and 1.7+302
Saing: A quoted sring of characher:
Mozel prewisw:
Angetl ol SO This previews s i of the model in the edtor, Select and diag

nadel Modsllane

!paramaters section

parameters
MAKTIME=300
USE_LOG=false

end-parameters

'Reat of the medel {declaracions, ScATementa, etc.)
'

end-model b

ENEE T

s data e

WzgnGraph - nieger
HP inla

ol
Perslisph:  inleger
PregGiaph nlegei
- selalinteger

FREF: ey [T AF) ol teger

Mosel astans/ scrach pud_ e s " .

Dk data bls
Mosel prewise: (0 & database [using DDBC)
il BLEWEN | This previewis o ol the model cpen n the edkor, Select and diog
Tassign valus{s} to ar A
a:=3.18

m 4. Variables Wizard
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[

Esisting decision vaiisbles

swogn: ey [AP.AP| of mpvan

1. Debuggrg Dreclare rew decision vaiisblsls)

1

o
[ Freee [abow negatie vakues]
ontrucus () Semisortinuous

Click, to awdd e 10 declaration
AP

"
‘

end-declarations

181l varisbles are crested conti
tuse "is continucus' to change tl

"~ G0boive

Th oby function mist be o soalan s

nct

1Hame i Type OrePeiPio): dyrsinie: avay 177 of ol
P

OreFicPes:  dmenic assy 777 of e

si0

m 6.

Dplimzation
Ditection Hgoiithm Seope
» @ Use defauk Opsmizer algorthm [uzualy dusl] @ P
@ Mirimzes 7 Frimal simphes 7 Sohvs LP, igroning dobal entiiss
) Masimize: 7 Dl simpke 7 Shep alter LP
" Baier ) Global seach any’
Mosel previse:
Angeil 8l N | Tris peviewis 7 S ar]

t Ienvake

ne Cptimizer to solve problem
we functicn Gbjective

Constraints Wizard
Mosetassant/sccoch pod IR TS 0 B

Moszel assistant / scratch

B Constiaints
Esisling Inear conshiainds
Cost lirchr
THeme &7 Mrlusk:  linck
z_PQW Balance dhanamic: anay 737 of bnch
J.Dats Input
1 aiabies
5 Dbjecti
7 Resdis & lunng
BT Dutput
?hﬁlenh'm .
11 Debuggig Declsie new conatrains] )
12 Compinte modek Click ho add 28 1o deckiation
1.2
s
range
MODES
Mozel previser: " Dlsatindex sot
(Cingetalcursot ] This previewsis noeded

Constrainthame : array() of linccr

m 7. Results & tuning Wizard
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7 Resls & huring
DOptimizer conirol parsmster categoriss Deasciiption
P 4 PMewton baser: The masimun number of berstionz
1 Hame & Tipe CPUTIME vivke the simpls d usualy post et of
2 Parameess LPITERLIMIT itesafions which iz: propertional b the rumber of
3.Data Input an B.aitier coniols MEIFSOL corsiants Umjhammlhsb-wiamm
AV anables MILF - guite b cul illd@w MEHNODE
5 Dbjective MILP - teanching and variable selection || MEXTIME fter  rumber of ferations Mlsrﬂeﬂeﬂkﬂ
B.Conztamis EIILF « heuristics m;&ﬁﬁg}g; Bfm m Thes m‘ ra}:lhu the Imfaemh
B.T et Dustput ek g BARITEHIJMII apecihis the madmum it of
4 Giaphing itesaiions which vl be cavied out by the banier,
10 Prograsmining ele. Tipe: |m o
11 Debugorg s i (]
120 % Set ceectives on global entities.
D Py ita0o0 |10
[ Force divectior @ Up () Dawn
ClUppeudocost |0
|| Down preudocast |0
Moged preview: -
(st sl cuteat ] Tris pevieuris ithe edior Solect and diag e
TModify Oprimizer com BARITERLIMIT =
setparam|"NEAS_BARITERLIMIT® value)
E
2l (! +

ETed Dudpd
&1 dota, variable and consirzint identifiers i ths modet

[eicGraph: inleger
Cost:  bwctr

THeme &7, ost
il FlowBiaph:  inieger
MING . integer
Minuan - Inch
ARCS: et cfi
gODES H

36t of shng
aveay [ARTS ange,1_2) & sting
s vy 717 of bech

cosT: mayLARCS]nf.

lows - vy
MECAR: i @Rcs] ofmew
MINCAP:  anay [SRCS) of i
pio avay NODES) of rlege

© aeay NODES] of weger

Wil o |7 Use fomalting
8 Standand outst Miimum length in characters: + |0
) Standud Masel dsa s ' i o =

Maselprevisse: 2 Aandorn s il sk - J

[Cingent al cursot ] This previewsis the edbor, Seect and diag resded

twrite walue of Identifier to cutput =
write (ldencifier)
< n +

Alraphing
Inchads the ocds mmive” i mock 10 enable access 10 diasing furctices
Flot cinkors:
® s -
() Custom cokoe
=5 Red
1 [ i
) Elpse n Ble [
Howto
[FlZoom [T
[T Evase: graphs
Sannple appboations = g
1 Plot & unidimensioral amay ® Ln | bl
Mosel previsse: ® Fota husi ickmensh w[x | wlr -
[Cinseil ol cursot | This pueviewsis i he eckor, Select and diag reeded
declarations -
gToph : dnteger
"
araph:=TVEsddplat (*¥ (¥) ", IVE_BLUE) \Czests & graph
Iomlxdir,d.ea in BCDES) do
rawpoint {gragh, ¥{index) ¥ (index})
wlabel (graph, ¥ (index) , ¥ (1ndex) ,sceing{index) | taprional
end=do
L3

m 10. Programming Wizard
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THame & Type Loops Comibticrel #atements
2 Paramenees -
3 [rsta Input ]
Dsaties ,m ) case.. of . enchcaze
£ Contiami =1 modal
7 Reaudits b luning oot "
B.T et Dutput 1) Exit programmatically
Sh Subvcudioes (possdees and hactons)
11 Debuggrg . ;
12 Cenngiatn modk: 2 Desclave & subwcating
1) Dedfine 2 subsodine

) Dvetkond & subrocine
More about
2 Scope of local declaration:
12 Patanglel Daing cormentie:

Mosel previse:
Angeil al CUISO | This preview s i inthe edikor, Select and

1) Wsing Optinize callbacks

Choose benching veiiskis calbeck
[ alzaton calback
calback

Ligg baiier
Log ghobal calba

Mo seiection calback

diag rmeded

tSample forall loop with 'mext'
declarations

apazzet of atring
end-declarations

forall (i in 1..10,3 in 1..10) do

if i=5 3=5 then mext: end-if

opas+=[ " 4aremr i, 3p4" *"aTring (3, 3)+"="+atrne (141, 31 ]
end-do

forallis in opa) writelnia)

<[ n

lkeep all multiplicatioas

lakip 5% or *S
tadd one at & time

11. Debugging Wizard

Dptivizer

12 Compinie mocals | Mozel - Oplimizet inleraction

Pesserve model remes in the Dptimizer maric

7 Oreler cobumn namer deleministically

1) Embed Oplinizer iunline logs i Mesel cutput

Obtak inlaasiily inlossalion

~ Esport the Mosel problem b a standaed WFS o1 LP fle

Moszel preiss:

(st st cuteat ] Tris peviewris ke edior Seect and

1) Slopping the Oplinizsr / corolieg bow long 1 uns

1.Hame & Type () Ceeate alog of Masel culput 1) Enable/disable preslve
2 Parameess
30t Input 20 Pause a unsing rodel bo inspect valses at a location () Requite detaked infarmation on infeasiobies
AV anables
5 Dbjective ) Gt i optind [optmal. inleasile. #ic | i) Dby
B.Conztaniz
7 Readis b luning 1) Obkain debaag indormation hom SOL operstion:
0.7 e Dutput
. Graphrg
[ elc.

diag rmeded

<[ n

12. Complete models Wizard

Wzmgrment Flores-shop schechdng Palibonng Sngle pencd product s
in packing Jain shop schedufrg Perzorend planning Symenetic TSP
i i Knapsack Portfcko optmization(OF) Timetabing
Ling: balancng Prmmgtive open thop Tuanspoi
Lot sizing Froduction planring Wehicle rcufing (VAP
Mzt o Froduction plarving *
Hisi [ Froject plansing w) corstiaintz
Mirimem vessght spenning e Purchaing with prics bresks
Mu-commody network low  Senuencing joos on a machine

Typs: Assgrment
.| Feshres  simpls LP problem, gaphical iepreseriation of resuits

Diescription: A vt of projschs & assigned o persons with the objective o medmize the ovessll satisfaclion & mefessnce rating per
pr=icgla e ) e P problsrm i § L it

e lacisions vatisbles explcll a: bnaries.
Mosel previsse: Oficdy. @1 ©2 ©3 ©4 08 Dnen model in editor View @ Mezallle 0 Dalslie
[Cinseil ol cursot | This pueviewsis i he edkor, Select and diag reeded

assigoment.nas

hesignment preblem
DIFFICULTY: 1

DESCR

"
‘

FEATURES: aimgle LF problem, graphical represencation of resulta

TFTION: A 2% of prolectd i assigned To perscns With the
sbjective to maximize The cversll satiafsction.
R preference rating per perscn and project is given.

] 3
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5.1 1. Name & Type Wizard

T S =

1.MName & Type

tdodel name: todelM ame [no blanks)
2 Paramters . Type of model: ) LP [p.ure linear pr.ogra.mming] )
3 Data Input MIP (integer or mixed integer programming)
4 Varisbles QP [quadratic programming)
g g:ﬁ?g:ts MIQF [mixed integer quadratic programming)
7 Results & tuning SLP [nhonlinear pragramming using sequential linear pragramming)
2 Test Output 5P [stochastic programming]
9.Graphing CP [zonstraint programming]

10.Pragramming etc.
11.Debugging
12 Complete models

1 Na mathematical programming features

Use graphing and drawing facilties in IVE

Use ODBC connections for data input/output from databases or spreadsheets
| Require statement temination with

Fequire all symbols to be declared befare use

tozel preview
This preview is independent of the model open in the editor. Select and drag or copy/paste as needed
model ModelName -
opticns noimplicit T
uses "mmxprs”, "mmive"”, "mmodbc™

m

'optional parameters section
!

writeln{"Begin running model™)
'
writeln({"End running model™)

end-model 2
4 m | F

The Name & Type wizard assists with creating the skeleton of a model. The skeleton source code
is updated to reflect options selected in the wizard window.

5.2 2. Parameters Wizard

2. Parameters

When embedding Mozel in an application, a string of parameter-value pairs
cah be passed az an argument when running the model e.g.:

1.Name & Type
¥PRMrunmad(model result, "MAKTIME =900 SE_LDG=tue");
3.Data Input . .
A ariables masel -c "exec madel.mas "MAXTIME=300,USE_LOG=true
5 Objecti
g Corlﬂict:rla\\r:ts These values will override the values specified in the text of the model
7 Results & tuning
. Text Output
AGraphing MNates:  The parameter tppe iz inferred by Mazel from its value.
10 Programming ete. .
11.Debugaing The parameters block must immediately follow the header of a mode!

12 Camplete models Parameters are treated az constants. Their value cannaot be changed at runtime.

Parameter types:

Boolean: true or false

Integer: An integer between -2,147,483 648 and 2,147 ,483,647
Feal A number between -1.7e+308 and 1.7e+308

String: A quoted sting of characters

Masel preview
This preview i independent of the model open in the editor. Select and drag or copp/paste as nesded.
model ModelName -

'parameters section first
parameters
MRETIME=300
USE_LOG=false B
1

m

end-parameters

'Rest of the model (declarations, statements, etc.)

1

end-model 52
4| m r
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The Parameters wizard shows a small typical example of using parameters in Mosel. The wizard
also shows how to interact with Mosel parameters from a programming language or the Mosel

console application.

5.3 3. Data Input Wizard

3.Data Input
Existing data identifiers
e
1.Name & Type AzgnlEraph Inkeger
P integer
PerzlGraph : integer
riams FrojGraph : integer
5.Obijective FF: zet of integer
6. Constraints . FREF : arrap (AP RF] of integer
7 Results & tuning
8. Text Output
9.Graphing
10 Programming ete.
11.Debugging
12 Complete models
Read from
@ Values manually written in the model () A standard Mosel data file
Mosel preview: () A random text file () A database [using DDEC)
This preview i independent of the model open in the editor. Select and drag or copp/paste as nesded.

'assign walue(s) to a:
a:=3.14

“ m

»

m

1

Mosel models can be separated into logic and data. The Data Input wizard attempts to obtain all
the "data" declarations in a model and then gives an example of how such data may be "read

in". Standard Mosel data files as well as reading from random files is supported/described.

Note that "data" can be of the types integer, boolean, real, string (not mpvar or linctr).

Xpress-IVE Wizards
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5.4 4. Variables Wizard

. o el
Mosel asistant / scratch pad_ it B . &
4V ariables
Existing decision variables
asEigh © array [RP.RP) of mpeear
1.Name & Type
2 Parameters
3D ata Input
5. Objective
E.Constraints
7 Results & tuning
8. Teut Output
9.Graphing
10.Pragramming etc.
11.Debugging Declare new decizion wariable(s) T
12 Complete models \dentifier ¥pe Click to add zets to declaration
[ Free [allow negative values)
ariableM ame = o
Semicontinuou:
(71 Scalar et Partial integer
Airay ynamic aray Semicontinuous integer
[\/ariableName. array(] of mpvar
Mosel preview * Clear index sets
This preview is independent of the model open in the editor. Select and drag or copy/paste as needed

declaraticns
VariableName : array() of mpvar
end-declarations

| »

m

'all variables are created continucus by default.
'use 'is_continucus' to change the type back to continuous if needed

1

4 [ | +

The Variables wizard can be used to declare and set the type of decision variables. Type the name
of a variable and select index sets (if an array). Optionally, specify the type of the decision
variable(s). Watch as the source code is constantly updated based on your selections.

5.5 5. Objective Wizard

Mosel assistant / scratch pod NI T B
5.0bjective
The objective function must be a scalar inear expression
3 atizfaction : linctr

1.Name & Type OnePersProj : dynamic aray 777 of inctr

2 Parameters OneProfPers : dynanic array 777 of linctr

3 Data Input

4 ariables

)

E.Constraints

7 Results & tuning

8. Text Output

9.Graphing

10.Programming etc.

11.Debugging

12 Complete models K K

Optimization
Direction Algoiithm Scope
Use default Optimizer algarithrn (usualy dual) Perfarm glabal szarch automatically
imal zimplex Solve LP, ignoring global entities
ual simplex Stop after LP
(71 Barrier ) Global search anly*
Masel preview
This preview is independent of the model open in the editor. Select and drag or copp/paste as nesded.

'Invoke the Optimizer to soclwve problem
'with cbjective function Objective

| »

minimize {Cbjective)

m

1

4 m 2
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The Objective wizard allows the selection of a linctr object as the objective function and explores
the various options available when optimizing a model.

5.6 6. Constraints Wizard

TrEmEEES E
B.Constraints
Hide windaw Existing linear constraints
Cost : lintr
1.Mame & Type hinGuant : linctr
2 Parameters Balance : dynamic array *¥7 of linctr
3.Data Input
4V anables
5 Objective
7 Resultz & tuning
8 Text Output
3 Graphing
10 Pragramming etc.
11 Debugging Declare new constraint(s)
12 Complete models | dentifier Click to add zets to declaration
- 1.2
Constrainttame ARCS
_ _ ARCS range
() Scalar @ Set NODES o
@) Array () Dynamic array
ConstraintMame : aray(] of linctr
iese) e ” Clear index sets
This preview is independent of the model open in the editor. Select and drag or copy/paste as nesded.

ConstraintName : array({) of linctr

| »

m

1

] m | b

The Constraints wizard can be used to declare linear constraints. Type the name of a constraint
and select index sets (if an array). Optionally, specify the type of the decision variable(s). Watch as
the source code is constantly updated based on your selections.
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5.7 7. Results & tuning Wizard

1.Name & Type
2 Parameters
3.Data Input

4 M arishles

5. Objective

8. Teut Output
9.Graphing
10.Pragramming etc.
11.Debugging

12 Complete models

tozel preview

7 Results & tuning

Optimizer contiol parameter categories

Pre
Simplex - primal & dual

Mewiton Barrier controls
MILP - cuts & cut strabe

MILP - heuristics
Output logs

and tolerances

gies

MILP - branching and variable selection

Set directives on global entities

[ Priority (1-1000):

1o

[ Force direction; (@) Up Down

[ Up pseudocast:

7] Dawn pseudacast:

]

1]

This preview is independent of the model open in the editor. Select and drag or copy/paste as needed

T =

Dezcription
Newton barier: The maximurn nurmber of iterations.
While the zimplex method usualy perfarms & number of

LPITERLIMIT iterations which iz proportional to the number of
MAMIPSOL cohstraints (rows) in & problem, the barrier method
MAMODE standardly finds the optimal solution to & given accuracy
M&<TIME after a number of iterations which iz independent of the
MIPABSSTOP problem size. The penalty is rather that the time for each
MIPRELSTOP iteration increaszes with the size of the prablem

BARITERLIMIT specifies the maximum number of
iterations which will be carried out by the barrier.
Type : Integer

Default Value: 200

"Modify Optimizer control parameter BARITERLIMIT -

getparam{"KFRS_BARITERLIMIT",value)

4

m

m

The Results & tuning wizard has two parts:

5.7.1 Optimizer control parameters

This interactive section groups all the Optimizer control parameters into families. Select a family
and then a control for a full description.

5.7.2 Setting directives on global entities

Global entities (integers, binaries, etc.) can be given higher branching priority. Other attributes
related to branching can be set for variables.
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5.8 8. Text Output Wizard

8. Text Output

All data, variable and constraint identifiers in the model:

ArcGraph integer
1.Mame & Type Cost lircte
2 Parameters FlowiGraph integer
3Data Input MING - integer
4 Vanables MinCuant : linetr
5. Objective ARCS : zet of integer
E.Constrairts MODES : zet of string
7. Results & tunin o anay [ARCS:range,1..2] of sting
Balance : dynamic aray 777 of linctr
9 Graphing COST: aray [BRCS) of integer
10 Programming ete. | | fow : array [ARCS) of mpvar
11.Debugging MaxCAR array [ARCS) of integer
12 Complete models | | MINCAP anay [ARCS) of integer
e anay [MODES] of integer
N anay [MODES] of integer

‘it o |7 Use fomatting

@) Standard output
() Standard Mosel data file

() & random file

Left justified Mirimum length in characters: + |2

@ Right justified . . .
X 2 I R Digits after decimal point E
tozel preview

This preview is independent of the model open in the editor. Select and drag or copy/paste as needed

'write walue of Identifier to output
write (Identifier)

4 [ |

| »

m

1

The Text Output wizard lists all entities in the current Mosel model and produces code for

displaying the values of the entities. Special formatting is optional. This wizard also shows how

to write to a file.

5.9 9. Graphing Wizard

9.Graphing
Include the madule "mmive’" in a model to enable access to drawing functions
1 Name & Tupe Graphing primitives Plat calors Fresiew
2 Parameters @ Predefined color | Blue e
3 Data Input
4 arishles () Custom color
5.0bjective =
E.Constraints 255 Fed
7 Results & tuning () Label
8. Text Output ® Rectangle 128 Green I
10.Programming etc. () Ellipse ] Blue [}
11.Debugging
12 Caomplete models
How to
[ Zoom [Constrain plot area between given coordinates)
[ Erase graph
Sample applications
(2 Plot a unidimensional aray x 1. v
Mosel preview (@) Plot a y(+] graph using bwo unidimensional amays w | '] w [Y
This preview is independent of the model open in the editor. Select and drag or copp/paste as nesded.
declarations

graph : integer
end-declarations

graph:=IVEaddplot ("Y(¥) ", IVE_BLUE) !Create a graph

forall {index in NODES) do

IVEdrawpoint (graph, Y (index), Y (index) )

'IVEdrawlabel (graph, ¥ (index) , Y (index) , string (index)) 'optional
end-do

| »

m,
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The mmive Mosel library can be used for drawing graphs in the User graph section of Xpress-IVE.
This wizard explains all the functions/options available for graphing.

5.10 10. Programming Wizard

1.Name & Type

2 Parameters
3.Data Input

4 ariables

5. Objective
E.Constraints

7. Results & tuning
8. Text Output

4. Graphin

11.Debugging
12 Complete models

Mozl preview

10.Pragramming ete.

@ Programming features in Mosel

Loops Conditional statements
@) forall () if .. then.. else . endf
) while ) case . of .. end-case
() repeat

21 Abort model

() Exit programmatically
Subroutines [procedures and functions]

() Declare a subroutine

efine a subrouting

() Overload a subroutine
tore about..
(©) Scope of local declarations
(0) Parameter passing conventions

(21 Using Optimizer callbacks
Select a callback

Chooze branching variable calback
Cut manager initialization callback
Cut manager node callback.

Cut manager termination callback:
Cut manager top hode callback

Log barier callback

Loa global callback

Log simplex calback

Mode cutoff callback

Mode infeasible calback
Mode optimal callback

Mode preprocessing callback
Node selection callback

Thiz prewiew iz \ndaeendent of the model open in the editor, Select and drag or copy/paste as needed.

'Sample forall loop with "next’

declarations

ops:3set of astring
end-declarations

forall (i in

ops+={""+strimt(i,3)+" *"+strimt (], 3)+"="+strimt [i%7,3)]

end-do

1..10,3 in 1..10) do
J=5 then next; end-if

forall{s in ops) writeln(s)

<

i ]

'keep all multiplications

'skip 5* or *5
'add cne at a time

'print it

| »

The Programming wizard has two parts:

5.10.1 Common Mosel programming tasks

Select a radio button for sample source code that exemplifies that feature.

5.10.2 Setting Optimizer callbacks for advanced interaction with the Optimizer

Check the Xpress documentation for more information on using Optimizer callbacks.
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5.11 11. Debugging Wizard

1.Name & Type

2 Parameters
3.Data Input

4 M arishles

5. Objective
E.Constraints

7 Results & tuning

8. Teut Output
9.Graphing
10.Programming ete.

12 Complete models

tozel preview

11.Debugging
Mosel
(7 Create a log of Mosel output

(71 Pauge a iunning model to inspect values at a location

() Get the status of optimization [optimal, infeasible, ete.]

() Obtain debug information fram SOL operations

Masel - Optimizer interaction

() Preserve model names in the Optimizer matris
() Order column names deterministically
Embed O ptimizer runtime logs in Mosel output

(") Obtain infeasibility infarmatiorn

() Export the Mosel problem to a standard MPS or LF file

Optimizer

() Enable/disable prasalve

(") Require detailed information on infeasibilibies
(7 Obtain more detailed logs

() Stopping the Optimizer # controliing haw lang it runs

This preview is independent of the model open in the editor. Select and drag or copy/paste as needed

4

m |

| »

m

1

The Debugging wizard lists a set of useful debugging features and how to use them. The features

are all accesible from Mosel and are grouped by the target of the debugging task:

m Mosel

m Mosel-Optimizer link

m Optimizer
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5.12 12. Complete models Wizard

Mosel assistant / scrach pad fed

12 Complete models

Assighment Flow-shop scheduling Partitioning Single period product mix
Bin packing Job shop zcheduling Perzonnel planning Symmetric TSP
1.Name & Type Bipartite matching Frapsack Portfolio optimization[(F) Timetabling
2 Parameters Blending Line balancing Preemptive open shop Tranzport
3 Drata Input Capital budgeting Lat sizing Production planning Yehicle routing (VAP
AV ariables Contract allocation b airnum Flows Production planning *
B Objective Caovering Iinirurn cost flow Project planning w/ constraints
E.Constraints Cutting stock, tdinimum weight spanning tree Purchasing with price breaks
7 Resuits & tuning Facility location Multi-commodity netwark flow  Sequencing jobs on a machine
2. Text Output .
9 Graphing Type: Aszsignmnent

10.Prograrming etc. | Features:  simple LP problem, graphical representation of results
11.0ebn

Description: 4 et of projects is assighed to personz with the objective to maximize the overall satisfaction. A preference rating per
person and project iz given. In thiz model formulation the zolution to the LP problem is integer, there iz no need to define
the decision variables explicitly as binaries.

tozel preview Difficulty: @1 D2 ©3 ©4 ©O5 Open model in editor Viewr @ Moselfile () Datafile
This preview is independent of the model open in the editor. Select and drag or copy/paste as needed
(! -

Mosel Example Problems |_‘

TYPE: Assignment problem
DIFFICULTY: 1
FEATURES: gimple LP problem, graphical representation of resulta

DESCRIPTION: & set of projects is assigned to persons with the
objective to maximize the owerall satisfaction.
L preference rating per person and project is giwven. 5
4 m | F

32 complete Mosel models are made available in this version. The models range from simple ones
(difficulty:1) to fairly complex (difficulty:5). Select a model type by clicking in the list to obtain
more information on the problem it adresses and the Mosel features it employs to solve the
problem.
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CHAPTER 6

Xpress-IVE Dashboards

Dashboards are special dialogs in Xpress-IVE that monitor the progress and performance of
various extensions of the Xpress suite.

6.1 Xpress-Kalis Scheduling Dashboard

g? Xpress-Kalis Scheduling Dashboard o (=[]
Scheduling elements excavator - e
: pilo-Crivey|  —
Resources [cpresource]: g ther e = = - e
Tasks [cptask]: 4B carpentry —_—
Makespan: 104  concrete-micer = = - " " i
Nodes: o 0,20 30 40 s0 B0 70 B0 80 0000
i B2 -
Solutions: 4 g3
B4
Gantt chart azpect BS
Time unit length 2
— AE1
D AB2
ABT
Fesource height ~ AR
ABS
Show precedences LEE
Pop up descriptions M1
. 2
[] Pozttion name near task 3 | —
4 I
Gantt chart behavior S
ME -
Update when solution found ECm 4
L =
[T Update after every node T ,*j
[7] Pause when solution found T2 [
T3 e
| Pause after every node T4 —
5
L&,
Kl =
w2 =
FE -
< [ b

he Xpress-Kalis Scheduling Dashboard is displayed after model execution for models that use the
Xpress-Kalis solver (Mosel module "kalis") and contain objects of types cptask and cpresource.
The upper part of the dashboard displays a resource usage chart. The lower half contains a Gantt
chart of the scheduled tasks. Arrows between tasks indicate precedence constraints.
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CHAPTER 7

XAD resource editor

7.1 Create XAD Forms using a Drag and Drop Interface

The XAD Resource Editor can be used to quickly create a form layout for use in XAD Mosel
applications. The layout, as defined by the user in the editor, is saved to file in a simple XML
format and may then be read in using XAD’s XADloadresource function. A full example for doing
this from the XAD Editor all the way to a XAD Mosel model can be found on the example page.

Xpress-IVE 64 bit - [Resource_003_named.rsc]

File Droject Edit View Buld Debug Deploy Modules Wizards Window Optimizer Help _Ex
DsE BEITE &[] @ Search: File Position: [a
% ) =] ) @
Toel Bar k3 [ Resource 500.rsc | [ Resource 310.1s+” [} Resource_003_named.rsc 4 b x| |Properties k3
Editor Options F2sm1 version="1.0" encoding="window: 2m7> + | stings ‘L‘
Flsnep ogid “xad_nead Compactlode="1" Languag: s (United States)" LANGI @[ [ v [ comamome |
[ Resize to grid 10" posy="10 Resource:  C:pressmplex
" posy="40" class="5UT [“caption:  canvas experim
p— <object id="3" caption="Shade" state="3" name="Shade” width="30" height="24" posx="17" posy="70" class="E
e i, ] 3 §
()| Button
Form Editor 2| [xPoston: 50
@ | Radio -
Checkbox T
e o Geometry (sctualjusable)
Input
Text Width: 750 742
CEW“ Height: 400 366

E] Browser
Group Network.
Progress Lines
Sarolber (H) Rectangles
Scrolbar (V) T
[E] rabs
Editor
Tree
Multiist

List

S
2
i
E
&
i

m i

True

é

Droplst

Text

Hide Group in Editor

Save Changes Delete

Promote Selection to Group

Ready Idle Free Memory: 1106 MB  Line:1/18 Cok0  READ ONLY OVR

This section contains the following topics:

The Drag and Drop Toolbar
m The Form Edit Dialog

The Properties Dialog

XAD Groups

m The Event Dialog
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m Tutorial Example

7.1.1 The XAD Resource Editor Form Edit Dialog

H

!
i

y
D§ i T
i . Pt

PEECEEEEEE§ §

PEfeqe

R

aaaaa

The Form Edit Dialog (FED) is used to construct a XAD window object containing XAD control
objects through a drag and drop style interface. A form created in this manner may be loaded
into a XAD Mosel model and the controls and objects on the form created from the resource file,
rather than creating the objects programmatically with Mosel code.

The form itself may be resized through the usual Windows methods of selecting an edge or
vertex and left-click dragging, or through an entry in the geometry input controls of the XAD
Properties Dialog.

In a similarly Windows fashion the form may be moved around the central XAD editor pane by
click-dragging on the form’s title bar. Should you wish to move the top of the form beyond the
top of the editor pane then you may do so via the form positioning control at the base of the
XAD Properties Dialog. The latter method may also be useful if you are editing on a small screen,
or with a particularly large form.

Note: To reposition the starting position of the form on the screen when first displayed via XAD
Mosel you will need to alter the Position input control of the XAD Properties Dialog. Moving the
form within the editor is simply for editing and has no runtime effect.

Once an object is placed on the FED and the properties altered you may wish to add events for
the object to a Mosel model file, or create groupings that may be manipulated as one object
within your Mosel code.

m Adding Events: Event callbacks may be added to a current, or new, Mosel file by double
left-clicking on the object you wish to add the event for. This will open up the Events Dialog
where you may add, or navigate to, event callbacks within the Mosel code of the specified
model. See the Event Dialog page for further details.

Note: In order to add an event callback to a file the file must be a valid Mosel model file.
Specifically, it must contain the "end-model" line.

m Select Groups: To select a group of objects you may hold down Control whilst clicking on
the individual controls. You can drag select a box around the desired objects (beginning the
selection box anywhere on the form background). Or, if you have already created groups of
objects you can select them via the Current Groups control in the XAD Properties Dialog.

m Delete Objects: In order to delete the currently selected object you must simply press the
Delete or Backspace keys.

m Repositioning the Form: You may reposition the form within the editor pane by clicking and
dragging as you would a standard Windows window; alternatively, you may use the FED
Positioning Control in the XAD Properties Dialog.
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7.1.2 XAD Resource Editor Groups

Groups
Current Groups:

Mame: | ProgressGroup
Wisible: | Ignore v
Disabled: v

[ Hide Group in Editor
Save Changes

Grouping together objects within the XAD Resource Editor allows multiple objects to be moved,
hidden or disabled simultaneously, both in the resource editor itself and, perhaps more
powerfully, from within XAD Mosel code.

There are two distinct types of object groups:

Temporary Groups: used simply to move around several objects at a time and keep
them at the same relative distances from each other. Temporary
groups may be promoted to permanent groups by pressing the
Promote Selection to Group button on the XAD Properties Dialog.

Permanent Resource Groups (PRG): permanent group associations of objects. These can be
manipulated within XAD Mosel code, hidden or disabled as a
group, and allow individual objects to belong to multiple groups
(see the 500selectiongroups.mos example discussed in the tutorial).
This type of group is stored in the resource file itself and may be
loaded in to XAD Mosel code to be associated with a particular
group id (see: example).

Groups of objects may be moved by selecting any member object and click-dragging it in the
same manner in which you would reposition an individual object on the Form Editor Dialog (FED).

Any selected group of objects will have a bounding box (visible in the image at the top of the
page) to display the extremities of the group. Within the FED this denotes the limits of
movement of the group. Any attempt to click and drag the group’s bounding box beyond the
edges of the FED will result in no further movement beyond the FED edge.

Any PRG may be selected, updated or deleted using the Groups control section of the XAD
Properties Dialog.

7.1.2.1 Groups Within XAD Mosel Code

Within XAD Mosel you may manipulate and use groups using the following routines:

XADgroupgetid Used to retrieve the integer id of a group loaded via a resource file.
It takes the arguments (groupName:string,
XADWindowID:integer).

XADgroupgetw Used to retrieve the integer pixel width of a group of objects. It
takes the argument (groupID:integer).

XADgroupgeth Used to retrieve the integer pixel height of a group of objects. It
takes the argument (groupID:integer).
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XADgroupgetx

XADgroupgety

XADgroupsetpos

XADgroupenable

XADgroupsetvisible

Used to retrieve the integer x-position of a group of objects. It
takes the argument (groupID:integer).

Used to retrieve the integer y-position of a group of objects. It
takes the argument (groupID:integer).

Used to move the group in unison. The new position sent to the
group defines the top left of the group bounding rectangle
(remembering that screen-based coordinates have the top left as
the origin). It takes the arguments (groupID:integer,
Xpos:integer, ypos:integer).

Used to enable or disable all members of a group. It takes the
arguments (groupID:integer, enable:boolean).

Used to show or hide all members of a group. It takes the
arguments (groupID:integer, show:boolean).

Additionally, you may also create or destroy groups purely in Mosel code using the following

procedures:

XADgroupcreate

XADgroupaddmember

XADgroupremovemember

XADgroupdisband

By creating a set of integers (the XAD ids of those objects you wish
to group) you can group them together using this routine. It
returns the newly created group id. It takes the argument
(objectIDs:set of integer).

Add an object to an already existent group. It takes the arguments
(groupID:integer, objectID:integer).

Remove an object from a group. It takes the arguments
(groupID:integer, objectID:integer).

Remove all objects from a group. It takes the argument
(groupID:integer).

Further details of these and other XAD routines may be found in the XAD Reference guide,

xadref.pdf.

7.1.3 XAD Resource Editor Event Dialog

Events Dialog e

Object Type: BUTTON

Object Name:  Text

Event: PRESSED -

Mosel file to add event to:

c:\wpressmpexamplesijvebinpacking. mos -

Cancel ] [GotoProcedure

This dialog allows the user to quickly add in events for specific objects on the Form Edit Dialog

(FED). It is opened by double
Options in the dialog:

left-clicking (or right-clicking, if you so desire) on the current object.
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Object Type and Object Name: These are read-only and simply indicate the type of the object
just selected and the name given to that object (see the XAD
Properties Dialog to alter this).

Event: The type of event to add. The selection list will change depending
on the type of object currently selected. For instance a BUTTON
object will not respond to WINDOW_OPEN events and so it will not
appear in the list. A full list of events and object types can be found
in the XAD Reference Manual, xadref.pdf, within the Xpress
installation "docs" directory.

Mosel File to Add Event to: Here you can select any open Mosel code file, choose to open
another Mosel file, or choose to create a new Mosel file. The
tutorial example creates a new Mosel file, but most commonly you
will wish to add events to a current file.

Cancel: Close the dialog without adding an event.

Go To Procedure: This will open the selected Mosel file and, provided it is a valid file,
add in the relevant callback and a small piece of code. This code will
simply display a message to the effect of "Not yet implemented"
and is simply meant as a placeholder until you add your own
functioning code to the callback. Note: If the callback already exists
in the file then you will be taken to that section of the code and no
new code will be created.

Note: If you alter the name of the objects, window or the callback name itself once it has been
created then the XAD code will not call that callback during code execution. The callback
mechanism works on the assumption that the auto-generated callback will have the name
structure "ObjectName_WindowName_EVENT". Should you wish for any reason to alter the
name of an object during code execution then you may do so using the XAD procedure
XADsetname (objectID:integer, newName:string), but great care should be taken when
doing so.

7.1.4 The XAD Resource Editor Drag and Drop Toolbar

R

Ik

This toolbar contains the various controls which may be dragged and dropped on to the Form
Edit Dialog (FED) as well as any general options specific to the editor.

The following controls may be selected for easier positioning and resizing of objects within the
FED:

Snap to Grid: When repositioning objects with the mouse the object’s (0,0) point,
or top-left, will position on the FED grid lines. The grid lines are
spaced 10 pixels apart in both the vertical and horizontal axes.
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Resize to Grid:

When resizing objects with the mouse the object’s edges, in the
direction of resize, will adhere to the FED grid lines. The grid lines
are spaced 10 pixels apart in both the vertical and horizontal axes.

To add a control, simply left click on the desired object icon in the left toolbar and, keeping the
left button depressed, move the object over the FED. Once the mouse cursor moves over a valid
"drop" point the cursor will change from a circular "forbidden" symbol and you may release the
mouse button. This creates the representation of the object at the "drop" point and you may
then move or resize the control by left clicking and dragging within the centre or the edges of the
control, respectively. This behaviour is much the same as standard Windows window behaviour.

The following controls may be dragged and dropped from the toolbar:

Button:

=
2/ Radio:

Checkbox:

ak| Input:

B
Canvas:
‘ Browser:

xy

Group Marker:

e Progress:

©¥ scrollbar (Horizontal):

5
= Scrollbar (Vertical):

Tabs:

=
=1 Editor:

o—

“a- Tree:

The standard Windows button control.

The standard Windows radio button control. Note that grouping of
multiple radio button objects does not cause them to actin a
mutually exclusive manner. This must be done programmatically
from within XAD Mosel.

The standard Windows checkbox control.

The standard Windows text input control.
A canvas object used for drawing on from within XAD Mosel.

An internet browser window. Set the initial page for the browser
using the URL field in the properties dialog.

The standard Windows group identifier box. Note that this has
nothing to do with XAD Editor groups.

The standard Windows progress display.
The standard Windows horizontal scrollbar control.
The standard Windows vertical scrollbar control.

The standard Windows tabbing control. Multiple tabs may be
added by separating the tab names with commas in the Caption
field of the XAD properties dialog. To create groups of controls
related to different tabs within the tab object, create multiple
groups and then assign a SELECTION event to the object. Within the
SELECTION event in the XAD Mosel code you are then able to hide
and disable, or show and enable, the various groups relevant to
whichever tab has been selected. Note: A maximum of three tabs
within a tab control will display in the editor. This limit does not
apply when running the actual XAD Mosel model.

The standard Windows multiple-line text entry control.

The standard Windows tree display control.
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« Multilist:

== List:

|

n
2

A Text:

Droplist:

The standard Windows multiple-column list control. The list may
also have its sorted flag set by setting the Sorted field of the XAD
properties dialog to true.

The standard Windows list control. Multiple items may be added to
the list by entering a comma-separated list within the Caption field
of the XAD properties dialog. The list may also have its sorted flag

set by setting the Sorted field of the XAD properties dialog to true.

The standard Windows droplist control. Multiple items may be
added to the list by entering a comma-separated list within the
Caption field of the XAD properties dialog. The list may also have
its sorted flag set by setting the Sorted field of the XAD properties
dialog to true.

The standard Windows read-only text display.

7.1.5 The XAD Resource Editor Properties Dialog

R

The Properties Dialog of the XAD Resource Editor is used to set the various window, object or
grouping properies of items on the Form Edit Dialog (FED). In some cases, such as altering size or
position, the attributes may be set using click-dragging within the FED.

The dialog itself is split up in to several sections, the behaviour of groups deserves a separate

page and so is covered in more detail here:

m Strings

Strings

Mame: | ®AD_TERT_1
Resource: | cildocuments al
Caption: | Progress:

— Name: The internal name given to the object currently selected (used if retrieving the
object id from XAD Mosel). This can contain any alpha-numeric character and the
underscore character. It should be unique.

— Resource: A read-only field containing the name and full path of the resource currently
being edited.

— Caption: If the current object has a text component (the window title in the case of the
form) then you may enter it here.
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m Position (parent-relative)

Pasition (parent-relative)

# Position: | 21
¥ Position: | 377

— X Position: The x position of the current object within the window; or, in the case of
the window itself, the starting x position on the screen when the window is first drawn.

- Y Position: The y position of the current object within the window; or, in the case of
the window itself, the starting y position on the screen when the window is first drawn.

m Geometry (actual/usable)

Geomekry {actualfusable)

width: | 100 100
Height: | Z0 0

— Width: The pixel width of the current object and the relevant size of the usable area.
The read-only "usable" text is currently only relevant for the window objects as they
have a non-client border area.

— Height: The pixel height of the current object and the relevant size of the usable area.
The read-only "usable" text is currently only relevant for the window objects as they
have a non-client border area.

m Special Attributes

Special Atkributes

Disabled: | False v

Visible: | True -
l—
l—

— Disabled: If you wish the object to be initially disabled (non-responsive to events and in
many cases greyed out) then set this control to true. The default is enabled, the control
set to false.

Visible: If you wish the object to be initially hidden then set this to false. True by
default. When set to false the object will be drawn with a small red X within the editor.
To actually hide an object within the editor it must belong to a group and the group
itself needs to be hidden using the Hide Group in Editor switch.

Sorted: If you wish list objects to be sorted when first displayed then set this to true.
False by default.

URL: This string field is currently only relevant for the browser object and should
contain the starting address (or home page, to use the common nomenclature) for the
browser object when it is first displayed. It will not display anything within the FED
object as this is not an actual browser window.

= Groups
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Groups

Current Groups:

Mame: | Progressisroup
Visible: | Ignore N
Disabled: i

[] Hide Group in Editor

Save Changes

Current Groups List: The list of groups currently associated with the resource. Selecting
from the list makes that group the current selection.

Name: The name given to the group, either a default name or a user-given name.

Visible: If you wish the objects within the group to be initially hidden (for instance if
you are creating a tab object with multiple tabs) then set this to false. Ignore by
default, meaning that the individual object settings for visibility will be honoured.
When set to false the objects of the group will be drawn with a small red X within the
editor. To actually hide a group of objects within the editor the group needs to be
hidden using the Hide Group in Editor switch.

Disabled: If you wish the objects of the group to be initially disabled (non-responsive to
events and in many cases greyed out) then set this control to true. Ignore by default,
meaning that the individual object settings for command response will be honoured.
Note that this control will override any previous setting for the individual objects.

Hide Group in Editor: Hide the currently selected group in the editor window. This is
only for display in the editor as you are currently working on it and does not affect
run-time display of the objects.

Save Changes: Save the changes to the current group (such as a change of name or
visibility status).

Delete: Remove the current group from the groups list.

m Other controls

Promote Selection To Group: Clicking this button whilst having a number of objects
selected (through shift-clicking, or via drag-selection) will promote that current
temporary selection to a saved group which you may then edit via the Groups controls.

[ Promote Selection to Group ]

The FED positioning control: This displays the current position and size of the FED
within the editing pane area. Should you wish to reposition a particularly large FED
you may do so by click dragging the representation of the FED around the control
surface. It will not allow you to move the FED to a position completely outside of the
positioning control’s field of view.

7.1.6 XAD Resource Editor Example

In order to demonstrate the use of the XAD Resource Editor and the associated XAD Mosel
commands we will now look at the example "500selectiongroups.mos”, in the XAD examples
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folder of the Xpress installation. This example not only covers the use of resources, but the
manipulation of resource generated groups within Mosel code and the use of an object in

multiple groups.
B o e
L1
Eddooe BC
- = | =
+

=

T =

[Burore | Caraa | Taat [ et
Buon 1 BT
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Bution 3

To begin with load the "500selectiongroups.mos" file in to IVE and view the behaviour of the
model when run.

In the example the tab object works by picking up the tab’s SELECTION event, calling the relevant
Mosel callback (Tabs_Window_SELECTION) and then setting the enabled and visible flags of the
objects relevant to the currently selected tab. In this case the code required to do this is
reasonably simple as we have setup groups of objects which we may hide or show with one

command. Herein lies the power of object groups.

We will now look at the various sections of the example’s Mosel code, before looking at the
associated resource in the XAD Resource Editor. Finally, as a tutorial, we'll create a new resource
containing a simple tab object and a few tab-associated controls.

7.1.7 The Mosel Code

[ so0selectiongroups.mos | [ Resource_S00.rsc

4k x

elif

else

end-
end-proc

procedur
HADw
end-proc

EhDgroupensble (id_group_¢, false)

EhDgroupensble (id_group_ T, false)

EhDgroupensble (id_group B, true)
end-procedure

procedure Tabs Window SELECTION
tabgel:=XiDltabgettsb (id tab)

if tabsel="Buttons" then lP()Tabs Windaw_SELECTION

Zibgroupsetviaible (1d procedure Tabs_‘Window_SELECTION
HiDgroupsetvisible (1d growp——mmroor—To=o=T

HiDgroupsetwvisible (1d_group_text, false

Anvthing whick disables should go first 1f members
lof two groups overlap (whichever group goes last
fwill take precedence)

Zhbgroupensble (id_group C, false)

Hibgroupensble (id_group T, false)
HiDgroupensble (id group B, true)

tabsel="Canvas" then

HiDgroupsetwvisible (1id_group_button, false
XiDgroupsecvisible (id group_canvas, true
XiDgroupsetvisible (id_group_text, false
Zibgroupenable (id_group B, false)
Zibgroupensble (id_group T, false)
Zhbgroupensble (id_group €, true)

HiDgroupsetwvisible (id group button, false
HiDgroupsetvisible (id_group_canvas, false
HADgroupsetwvisible (1d_group_text, true)
XiDgroupensble (id_group E, false)
XiDgroupensble (id_group C, false)
Zibgroupensable (id group T, true)

if

edure

e Exit Window PRESSED

indowslose (id win)
edure
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The Mosel code has the following parts (ignoring those parts common to standard Mosel models):

®m Load the window from resource:
Here we load the resource file in to the model. All resources equate to one XAD window
and the return value of the function used to load the resource, XADloadresource, is the id
of the XAD window object (id_win, in this case).

m Retrieve the object/group ids:
Although we need not retrieve the object ids for all of the resource objects, if we wish to
manipulate or respond to events for that object we must do so. When creating the resource
each object/group will have been given a name (either the default
"XAD_OBJECTTYPE_COUNTER", or set by the user) and it is this that we will use to retrieve
the object ids.

Using the XAD functions xADgetid and XADgroupgetid we may retrieve the ids for objects and
groups, respectively.

m Display the window:
This function opens the specified XAD window and displays all the associated objects. In
order to only display/enable those objects relevant for the initially displayed tab we will
need to setup the object states when the window opens. This is achieved via a
WINDOW_OPENED event callback.

m procedure Window_WINDOW_OPENED:
In this callback we need to setup the various states of the objects/groups belonging to each
tab selection. There are six groups within the example, 3 relating directly to those objects
displayed on each tab, and 3 relating to the buttons on the right hand side of the example.

The right hand side buttons demonstrate that when the Button, Canvas or Text tabs are
selected the relevant buttons are enabled or disabled. These differ from the groups setup
for the objects in the tab control as each button may belong to more than one group
(Group B, C or T depending on which tab selections they will be enabled for).

We intially have the "Button" tab selected and so within this callback we enable the
id_group_button and id_group_B groups and disable the others.

Note: there are no events associated with the buttons in this example and so they will not
actually perform any action if clicked.

m procedure Tabs_Window_SELECTION:
This callback is in essence very similar to the WINDOW_OPENED callback, above. The
difference being that we must check for the currently selected tab and then disable/enable
and show/hide the relevant groups for each tab.

As the comment in the code mentions, it is important to get the order of the commands
correct if you are dealing with objects in multiple groups. Were the command order
incorrect you may inadvertently enable and then disable an object (belonging to multiple
groups) that you intended to be enabled.

Note: It is recommended to first disable all the groups you need to before finally enabling
the relevant group or groups (as in this example).

m procedure Exit_Window_PRESSED:
When the "Exit" button is PRESSED this callback is called. All it does is cleanly close the
id_win window so that the program closes in a user controlled and clean manner.
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7.1.8 The Associated Resource File

The resource file associated with the example, "Resource_500.rsc", can be found in the XAD
examples directory alongside the Mosel file. Once loaded in to IVE you will be presented with the
XAD Resource Editor and the representation of the XAD window and objects will be visible in the
Form Edit Dialog (FED).

Grouping Demonstration

Buttons | Canvas ‘ Text B.C.T

Button 1

m
=

Button 2

Button 3

Editor d
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[
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Exit

When initially loaded all of the objects within the tab will be visible. To hide a group of objects
within he editor select the group from the XAD Properties Dialog Group drop-down list and then
select the option to Hide Group in Editor.

This behaviour can be used to quickly shift between group selections designed for use in tab
objects. In this example we will hide the Buttons group and show the Canvas group:

m Select the group you wish to hide:
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Here we've selected the Buttons group. It's currently visible in the editor.
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m Hide the Buttons group:
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By selecting the Hide Group in Editor option we hide the Buttons group.

m Unhide the Canvas group:
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By selecting the Canvas group in the drop-down list, and unselecting the Hide Group in
Editor option, the Canvas group becomes visible in the editor.

The events for the objects on the resource may be added, or navigated to, via the XAD Event
Dialog. This is shown when an object, or the form itself, is double left-clicked.
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Events Dialog

Object Type: BUTTON

Object Name: Exit
Event: Eﬂ -

Mosel file to add event to:
c\wpressmpexamples\xad!500selectiongroup

Cancel | [GomProcedure

As an example we will now navigate to the Exit button callback discussed earlier. To do so, firstly
double click the Exit button in the FED to open the Event Dialog for the button. Once this is open
we can navigate to the event callback in the following manner:

m Select the Event:
In this case we wish to select the PRESSED event, but were you adding a different event you
could select any of the events offered to you in the drop-down list.

m Select the Mosel File:
We wish to navigate to the event callback already set in "500selectiongroups.mos”, but you
could choose to add the event to any valid Mosel file in which you intend to load the
"Resource_500.rsc".

m Go to Procedure:
Once you've selected the event and file you wish click the button and you will be taken to
the relevant callback in the file specified. In this case the callback already exists and so you
should now see the XADwindowclose function call which forms the operational code of the
callback.

If you'd chosen to add a currently non-existent event callback to the file then the code part
of the callback would contain the default "Not yet implemented" Mosel text output.

7.1.9 Creating a Simple Tab Example from Scratch

In this section we will use the Resource Editor to create a simple tabbing application for XAD
from scratch, using the drag and drop features of the editor to layout the form and the Event
Dialog to add in a few simple events.

Firstly, create a new resource by selecting the New Resource option on the File menu. This will
create a blank form in the FED of the default size (500x500).

Now we’ll alter the form to the desired size and set its various attributes:

m Resize:
By clicking and dragging on any side or vertex of the form (or by entering the size in the
Properties Dialog) resize the form to around 600x400. It's recommended that if you want a
very specific size you set this via the Properties Dialog, otherwise using the mouse to resize
can be quicker and easier.

m Setup Strings:
Next you will need to enter a name for the form (XAD window) object. You may stick with
the default "XAD_WINDOW_NUMBER" if you wish, but you may find it easier to maintain
your Mosel program if you give it a more unique name. For this example you could enter
“Main_Window".
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Enter a caption for the window (the title which appears in the form's top bar) via the
Properties Dialog. For this example you could enter "Tutorial Window".

m Set the Window Position on Screen:
For this example we'll have the window open and display at half its own width and height
from the top left of the screen. If you've set a form width and height of 600x400 then set
the "X Position" to 300 and the "Y Position" to 200.

Next we’ll add a button object for closing down the program once it's started. This will involve
adding the button itself via the drag and drop editor, creating the new Mosel model file and
adding the PRESSED event to close the window in the Mosel code:

m Adding the Button Object:
Click and drag a button object from the drag and drop toolbar on the left-hand side of the
editor. Once your mouse cursor moves over a "droppable" area of the newly created form
you can release the mouse button; this will create a button at the position of the mouse
cursor. To refine the position of the button you may left-click and drag it within the form, or
you may enter the position in the Properties Dialog, as we did with the main form. In this
example we'll place the button towards the bottom right of the form.

m Modify the Button Attributes:
As with the main form we should give the newly created button a more descriptive caption
and, if desired, a more unique name. In this example we will mark the button as the "Exit"
button and give it the name "Exit".

m Add a PRESSED Event:
To make the button function when pressed we need to add an event via the Event Dialog.
With the "Exit" button selected (its attributes will be visible in the XAD Properties Dialog),
double left-click on the button to open the Event Dialog. Select the PRESSED event, as we
want this callback function to be called when the button is pressed, and make sure "Create
a new file" is selected as the Mosel file to add the event to. Now click "Go to Procedure"
and enter a location and name for your new Mosel file. For this example we'll call the new
Mosel file "Tutorial.mos".

You should now see the newly created Mosel file with the Exit_Main_Window_PRESSED
procedure inserted. As we want the procedure to close the window replace the default
code with XADwindowclose(id_win) as in the original example above.

In this instance, as we've created a new Mosel file, the code to load the resource and assign
this particular resource to the id id_win isn’t yet present. Had we added this to an already
existent Mosel file then we would of course close the window of whatever XAD id had been
associated with the resource.

To create a functioning application we now need to add in a little connecting code to load this
particular resource file and open the associated window:

m Enable XAD Code Usage:
As we'll be using the XAD Mosel module we'll need to add the line "uses "mmxad"" to the
Mosel code.

m Declare the Window ID:
Within the declarations section of the Mosel code you will need to declare the id of the XAD
window we will associate with the resource. In this case we're calling the id id_win, as
above. All ids are simply integer values and therefore we must add the line "id_win:
integer".
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m Load the Resource: To associate a resource with an id the resource (and thus its associated
objects) are loaded using the XAD function "XADloadresource". This function returns the
integer id it has associated with the loaded resource and we assign this to id_win.

Note: if your Mosel code file and resource file are saved in different folders then you will
need to specify a path to the resource file in the argument to "XADIloadresource".

m Open the Window and Begin Execution:
In order to hand control of the application to the "Main_Window", id_win, we need the
program to display the window and associated controls. To do so use the XAD function
"XADwindowopen(id_win)".

m Exit the Program:
To cleanly exit and end the main section of the code we now add the "exit(0)" command to
the Mosel code.

m Cleanup the Code:
Whenever a new Mosel file is created in IVE there may be default sections that are
inappropriate to your program. In this case we do not require the reference to "mmxprs",
the "parameters" section or the Mosel "writeln" code and so they can be removed.

The Mosel code and resource should now look like similar to the images below and you should be
able to run the application in IVE. Try running the program and notice that we can exit using the
button and event we've created.

Tutorial Window

model ModelName
uses "moxad”

declarations
id win: integer

end-declarations

id win := HiDloadresource ("Tutorial.rsc'”)

EADwindowopen(id win)

exit (0]

procedure Exit Main Window PRE3ISED
EADwindowelose (id_win)

end-procedure

end-mode 1

Finally, we'll add the tab object with a couple of XAD objects associated with each tab:
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m Add the Tab Object:
In the same manner in which you added the button, previously, add a tab object to the
form. Again, in the same manner as the button, give it the name "The_Tab" and position it
towards the top left of the form. Now, in the same manner as you resized the form object at
the start of the tutorial, resize the tab object to fill the form to the right of the "Exit"
button.

m Create Multiple Tabs:
Instead of having a single caption or title, the tab object has tab captions to the top of each
tab. These are added in the same manner as the caption added to the "Exit" button, but
with the tab captions delimited by the comma character.

In the XAD Properties Dialog enter "Eric,Ernie" in the Caption field. This creates two tabs on
the tab object. A maximum of three tabs will be visible on the FED, although you may enter
as many comma-separated tab caption entries as you wish in the Caption field.

The resource editor should now appear similar to the following:

Tutorial

Eric Ernie

m Add Objects for Each Tab:
On each tab we want different objects to appear. In this example we will create canvas and
text objects on the "Eric" tab and a web browser on the "Ernie" tab:

m In the same manner as the other drag and dropped objects, add a browser object to the
form and reposition/resize it to sit over the tab object. You will need to drop the browser on
a section of the form itself.

m Next set a name for the browser, "Browser" in this example, and set the URL field to the
web page you wish it to open on when clicked, www.fico.com in this example.

m All objects associated with a tab should be grouped together. For the "Ernie" tab the group
consists of the single browser object, "Browser".

Whilst holding down the Control key left click on the browser object. This creates a
selection group.

To make this a permanent group, for use in XAD Mosel code, you now need to promote this
to a group using the Promote Selection To Group button of the XAD Properties Dialog. This
creates a group called "Group_1".

Rename this newly created group to something more unique, such as "Group_Ernie" and
set the Visibility to False and Disabled to True as initially the "Eric" tab will be visible. Click
"Save Changes" to save the group updates. All of the commands to rename and update
groups are to be done via the Groups section of the XAD Properties Dialog.
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Now hide the browser object in the editor so that we can add the "Eric" tab objects. With
"Group_Ernie" selected click the "Hide Group in Editor" checkbox on the XAD Properties
Dialog.

m For the "Eric" tab add the canvas and text objects in the usual drag and drop manner. For
the sake of keeping the Mosel example code simple in this example the canvas object will
simply be blank. The text object may contain any text you wish and may be entered via the
Capion field of the XAD Properties Dialog. In this example the objects have been given the
names "Eric_Canvas" and "Eric_Text".

By Control clicking the "Eric_Canvas" and "Eric_Text" objects create another group called
"Group_Eric". This group should be visible and enabled.

m Add the SELECTION Event Callback:
Now that the groups of objects are setup we should add the tab SELECTION event callback
to the Mosel code so that something actually happens when the tab with focus is changed.
Double left-clicking on the "The_Tab" object open the Event Dialog, select the SELECTION
event and the Mosel file you created previously and "Go to Procedure".

m Associate Code-Referenced Objects with Resource Objects:
Any objects, or groups, created in the Resource Editor that you wish to manipulate in the
Mosel code must have an associated id. In this example we will reference the "The_Tab"
object and the two groups "Group_Eric" and "Group_Ernie". To associate an integer id with
these objects use the two XAD Mosel functions XADgetid and XADgroupgetid, both of
which take the string name of the object or group and the id of the XAD window it is
associated with, id_win in this case.

m Add the Tab Selection Handling Code:
When either of the two tabs is selected we want to show and enable the objects associated
with it and hide and disable those objects not associated with it.

Within the The_Tab_Main_Window_SELECTION procedure use the XAD Mosel function
XADtabgettab(id_tab) to retrieve the string name of the currently selected tab. Compare
this name to the two tab names "Eric", or "Ernie" and enable/show or disable/hide the two
groups as appropriate using XADgroupsetvisible and XADgroupenable.

This should result in the following resource and Mosel code:

Tutorial Window

Eric | Ernie
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model Mode lName
uses "moxad”

declarations
id win: integer
id tab: integer
id group_eriec: integer
id group ernie: integer
end-declarations

id win := XiDloadresource ("Tutorial.rsc"”

id tab := HADgetid("The Tsb", id win)

id group eric := HADgroupgetid ("Group Eric', id_win)
id group_ernie := HADgroupgetid|"Group Ernie”, id win

EADwindowopen(id win)
exit (0]

procedure Exit Main Window PRE3ISED
EADwindowelose (id_win)
end-procedure

procedure The Tab_Main Window SELECTICH
tehsel:=Xibtabgettab (id_tab)
if tabsel="Eric" then
ZiDgroupsetvisible (id group ernie, false
ZiDgroupenable (id group ernie, false]
ZiDgroupsetvisible (id group eric, true]
ZiDgroupenable (id group eriec, true]
else
ZiDgroupsetvisible (id group eric, false)
ZiDgroupenable (id group eric, false)
IiDgroupsetvisible (id group ernie, true]
EiDgroupenable (id_group ernie, true)
end-if
end-procedure

end-model

You have now created a very simple working example using the resource editor, groups and
events. Provided you have saved all changes to the resource file you should now be able to

run the example and switch between the tabs successfully.
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